
This chapter introduces you to the AIX operating system for use on the
Network Server. It covers the following topics:

m software configuration

m user interfaces

m AppleTalk and Mac OS applications

m introduction to standard AIX system management tools
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Introduction

For information on setting up the Network Server, consult Setting Up the
Network Server, which came with your Network Server, before you install AIX
or perform any other procedures discussed in this manual.

This manual assumes that you are administering the system either from a
console—a monitor and keyboard directly connected to the Network Server—
or from a remote Macintosh computer.

If you are planning to work on a console that is directly connected to the
Network Server, consult Setting Up the Network Server for hardware
specifications. The console allows you to use the AIX graphical interface—
AIXwindows or the Common Desktop Environment (for information, see
Chapter 4 of this guide). If you are administering the system from a remotely
connected Macintosh computer running Macintosh System 7 or later, you can
use the Disk Management Utility and CommandShell (see Chapters 8 and 9
of this manual).

You can also use a remotely connected X server, such as MacX on a
Macintosh computer.
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System software components

Your Network Server uses three basic types of software: 

m application programs

m device drivers

m the AIX operating system

The following figure shows the relationship between the different software
programs and the hardware.

Application programs

Application programs allow you to perform specific user tasks, such as
running databases, file servers, or computer-aided design programs. 

Device drivers

Device drivers interact directly with computer hardware elements, such as
printers and monitors, and shield the application programs from the hardware
specifics of computers.

Computer system software relationship

Application programs

Device drivers

Operating system

Hardware platform
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Operating system

The operating system is a collection of programs that control the running of
the computer and organize the resources of a computer system. These
resources are the hardware components of the system, such as keyboards,
printers, monitors, and disk drives. The AIX operating system comes with
executable programs or utilities that maintain your files, send and receive
messages, provide miscellaneous information about your system, and so on.

An application program relies on the operating system to perform many
detailed tasks associated with the internal workings of the computer. The
operating system also accepts commands directly from you to manage files
and security.

Root-user processes and root permission

Root-user processes are programs that can be run only by a user with root
permission. A system administrator has root permission for all processes,
which allows him or her to

m read, write to (that is, change), or execute any program or file

m call any system function

m perform certain subsystem-control operations

If you are not allowed to run a command or to read or change a file, the
system displays a message saying you do not have the correct permissions or
you are not allowed to run that command. The system administrator may be
the only person who can log in as root on your system. However, the system
administrator can grant a user permission to use particular commands, giving
that user some control over processes.

4 Chapter 1 / Introduction to the System



User interfaces

There are two types of user interfaces: the graphical user interfaces and the
command-line interface.

Graphical user interfaces

When a user interface has graphic objects, such as windows and menus, it is
called a graphical user interface (GUI). This section describes the following
graphical user interfaces: 

m AIXwindows

m The Common Desktop Environment (CDE)

AIXwindows

AIXwindows lets you move windows, resize them, and copy text from
window to window. It allows applications to run separately and appear
simultaneously in different windows on your monitor. 

The aixterm terminal window, in the AIXwindows interface, emulates a
terminal. It contains a command-line prompt that allows you to run UNIX
commands. The AIXwindows interface is also used by many applications that
run on AIX. For a detailed description of the AIXwindows interface, see
Chapter 4.

The Common Desktop Environment

The Common Desktop Environment (CDE) allows you to use icons to access
networked devices and a wide variety of applications without having to be
aware of their locations, startup commands, or command-line options. It
allows you to exchange data across applications simply by dragging and
dropping objects. 
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The command-line interface

The command-line interface is a character-based interface. It is also known as
the shell. The screen displays a system prompt, and the commands you type
from the keyboard appear next to the prompt. 

The Disk Management Utility and CommandShell

In addition to AIX 4.1.5, the software used to run the Network Server also
includes the Disk Management Utility and CommandShell, which were
created by Apple for use with AIX on the Network Server. These applications
run on a remotely connected Macintosh computer. They connect to AIX
daemon processes to allow you to perform system administration tasks.

m The Disk Management Utility. This application allows you to manage all
aspects of disk storage. It uses a graphical user interface that offers various
views of the disk storage structure as well as methods of adding to, deleting
from, and modifying the disk storage structure. For more information, see
Chapter 8, “Managing File Storage With the Disk Management Utility.” 

m CommandShell. This application is a terminal emulator that runs multiple
windows on your screen so that you can run different AIX applications or
processes simultaneously. For more information, see Chapter 9, “Remote
Access With CommandShell.”
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AppleTalk and AppleTalk services

You also have available to you AppleTalk and AppleTalk networking services,
created by Apple and engineered for use with AIX on the Network Server.
Your Macintosh clients can use AppleTalk to access the AIX server without
using TCP/IP, or your clients can use AppleTalk over TCP/IP and enjoy the
increased speed. You can also route AppleTalk packets over the Internet using
TCP/IP. For more information, see Chapter 7.

For information on standard network protocols, such as TCP/IP, see the
InfoExplorer article “Network Overview for System Management.”
InfoExplorer is described in Chapter 5. 

Standard AIX system management tools

In addition to conventional command-line system administration, AIX
includes several system management tools and installation utilities, including
the Install Assistant, System Management Interface Tool (SMIT), and Visual
System Manager (VSM). 

The Install Assistant application guides you through customization tasks. The
interface for Install Assistant provides step-by-step instructions for
completing each task. The application tells you why you would want to
perform certain tasks. If you are familiar with the tasks, you can skip the
instructions. 
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System Management Interface Tool (SMIT) is a menu-based tool that
constructs and executes commands from the options you choose. With SMIT
you can 

m install, update, and maintain software

m configure devices

m configure disk storage units in volume groups and logical volumes

m make and extend file systems and paging space

m manage users and groups

m configure networks and communication applications

m configure printers

m identify system problems

Visual System Manager (VSM) provides a graphical interface that lets you
manage your system by directly manipulating icons. You can use tools in VSM
to perform many of the same tasks as the SMIT application. The VSM tool
includes the following applications:

m Device Manager, which displays system objects and dialog boxes that
represent your system’s device configuration database. This allows you to
manage objects such as graphic adapters, ports, buses, and memory cards. 

m Print Manager, which allows you to perform basic SMIT tasks on printer
and print queues. 

m Storage Manager, which lets you manage physical volumes, volume groups,
logical volumes, and file systems through manipulation of icons. 

m Users & Groups Manager, which lets you add users with simple templates.
You can also set passwords and the default interface for users. 

For information on using VSM, see Chapter 6, “Using System 
Administration Tools.”

The software for the Network Server also provides Mac OS utilities that
provide a Macintosh interface for logical volume management (the Disk
Management Utility, described in Chapter 8) and terminal emulation
(CommandShell, described in Chapter 9).
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Where to go from here

If you have not yet installed AIX, proceed to Chapter 2. 

Note: If you plan to use the Redundant Array of Independent Disks (RAID)
software as your disk controller, install RAID before installing AIX. If you
install RAID after AIX has been installed, you will have to reinstall AIX.
Back up your disks carefully following the backup instructions in Chapter 2. 

If AIX has already been installed, proceed to Chapter 3.

For information on the AIXwindows interface, see Chapter 4.

For information on InfoExplorer, see Chapter 5.

For information on administering the system, particularly if you need
assistance with AppleTalk, the Disk Management Utility, or CommandShell,
see Chapters 7 through 9. 

For troubleshooting assistance and information on error messages, see 
Chapter 10.
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This chapter describes how to install the AIX Base Operating System (BOS).
This chapter also describes how to perform initial system configuration. 

The topics covered in this chapter include

m getting ready for installation

m installing the BOS

m setting up your system after you have completed the BOS installation program

m backing up your system

m installing the BOS from a system backup

m installing Mac OS utilities on a remote Mac OS client
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Before you install

Before you begin the AIX installation process, do the following: 

m Set up your hardware and connect any peripheral devices such as an
additional hard disk drive.

m Locate your Installation CD and Apple AIX Easy Install 3.5-inch disk.

m Obtain the Network Server key.

You must install the operating system on the local system (your Network
Server).

For information about setting up your hardware, see Setting Up the 
Network Server.

Installing the AIX Base Operating System

Follow these steps to install the AIX Base Operating System. 

1 Turn on your Network Server.

2 Insert the Installation CD into the drive and insert the Apple AIX Easy Install 
3.5-inch disk.

3 Turn the front key to the left (service) position.

4 Restart your Network Server with the CD in the drive.

To restart your system, press the reset button.

When your system starts up, it will use the Installation CD as the boot disk.

If you are upgrading the software on your Network Server and you insert
your Installation CD and 3.5-inch disk, you may see the following error
message:

Reset button
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fd:diags. FD can’t load from this deviceOpenFirmware

2.26. To continue booting from the default boot device

type BOOT <return>.
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To boot from the CD, type

boot cd

Once the system restarts, a message appears asking you to define the system
console.

5 Press F1 and then Enter to use the local display as your console.

If you have a standard keyboard (without function keys), the top row of the
keypad serves as the function keys F1 through F4. If you have a standard
keyboard, press the Clear key on the keypad instead of F1. 

6 When prompted, select  a language for installation instructions.

For English, type 1 and press Enter.

The following message appears on your screen.

7 To begin installation, type 1 and press Enter.

To examine or modify installation settings, you can type 2 and press Enter.

The Installation and Settings screen appears.

Welcome to the Base Operating System

Installation and Maintenance

Type the number of your choice and press Enter.

Choice is indicated by >>>.

>>> 1 Start install now with default settings

2 Change/show installation settings and install

3 Start maintenance mode for system recovery

88 HELP ?

99 PREVIOUS MENU
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Use this dialog box to specify the following:

m the installation method

You can choose either the New and Complete Overwrite option or the
Preservation Install option. The New and Complete Overwrite option
erases all the information on your hard disk before installing the BOS. The
Preservation Install option keeps the user data in the root volume group
when it installs the BOS.

Installation and Settings

Either type 0 and press Enter to install with current

settings, or type the number of the setting you want 

to change and press Enter.

1. System Settings

Method of installation.............Preservation

Disk where you want to install...........hdisk0

2. Primary Language Environment Settings (after 

install):

Cultural Convention......English (United States)

Language.................English (United States)

Keyboard.................English (United States)

Keyboard Type............Default

3. Install Trusted Computing Base...............No

>>> 0  Install AIX with current settings listed above.

88 Help ?

99 Previous Menu

WARNING: Base Operating System installation will

destroy or impair recovery of some data on the

destination disk HDISK0.
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m the destination disk 

m the language environment 

m the Trusted Computing Base (TCB) setting 

The Trusted Computing Base tries to ensure that the programs you run are
trusted programs. If you want to change the TCB setting, do so during
installation. This setting cannot be changed later.

8 When you have selected the appropriate settings, type 0 and press Enter to begin 
the installation.

The Installing Base Operating System dialog box shows you the progress of
the installation and informs you when the installation is complete.

The installation program installs two groups of file sets. The first group
contains about 100 file sets (the exact number depends on your system
configuration). The second group of file sets contains about 200 file sets.

The installation process for the BOS takes about 45 minutes to 1 hour to
complete.

9 Turn the front key back to the upright (unlocked) position before the installation is
completed.

When the BOS installation completes, the installation program restarts your
computer. The key must be in the upright position during this restart to boot
from the hard disk instead of the CD.

The BOS is now installed along with all the licensed software to accompany
it. The next section lists the customization tasks that you need to perform to
set up your system initially.
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Performing initial setup and administration tasks

After you have installed the BOS and additional software, the system can run
with its default settings: one user (root), the date and time that was set when
the system was manufactured, and other general settings. However, you
probably want to customize these settings and provide additional information,
such as a network configuration. 

To customize these settings, use the Install Assistant. The Install Assistant
provides step-by-step instructions for completing each customization task.
The application also tells you why you would want to perform certain tasks. If
you are familiar with the tasks, you can skip the instructions and simply
complete the tasks.

After you have installed the BOS, your computer restarts and automatically
starts the Install Assistant application.

These are some of the tasks you may need to perform:

m Set the system date and time. 

m Set a root user account password and restrict access to system resources.
This step is vital to ensure the security of your computer. 
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m Set up your TCP/IP network environment. 

For more information about configuring your TCP/IP environment, use
InfoExplorer to access the onscreen documentation. You can learn how to
use InfoExplorer in Chapter 5, “Using InfoExplorer to Retrieve Information.”

IMPORTANT Be sure to configure TCP/IP correctly. If you don’t, your server
may take a long time to start up or it may take a long time to start the
Common Desktop Environment (CDE). If you experience these types of
problems, see “Slow Startup Problems” in Chapter 10, “Troubleshooting,” for
more information.  

m Change the primary language environment.

m Create user accounts. 

m Configure your printer and add print queues for local printers and remote
print servers. See Chapter 7, “Setting Up AppleTalk and AppleTalk
Services,” to learn how to set up an AppleTalk printer and print queue.

m Import any existing volume groups. 

m Back up your system. See “Backing Up Your System,” later in this chapter,
for information about backing up your system.

After you’ve finished your customization tasks, select the Install Assistant task
item “Tasks Completed—Exit to AIX Login” to quit the Install Assistant and
ensure proper configuration.

You can access the Install Assistant at any time by entering the command
install_assist.

For more information about any of these tasks, consult the onscreen
documentation with InfoExplorer.
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Setting your display resolution

After you’ve installed the operating system, you may want to customize your
display resolution. 

To set your screen preferences, you need to log in to AIX. For information
about logging in, see Chapter 3.

To set your screen preference, follow these steps: 

1 Start SMIT.

To start SMIT, enter smit on the command line. See Chapter 6 for more
information about using SMIT.

2 Choose Devices.

The Devices menu appears.

3 Choose Graphic Displays.

The Graphic Displays menu appears.

4 Choose “Display Resolution and Refresh Rate.” 

SMIT displays a list of available devices.

5 Click the device name. 

A dialog box appears with the attributes for the device.

6 Specify your resolution and refresh rate.

Use the List button to display the available resolutions and refresh rates.

For example, you can set your resolution and refresh rate to 1024x768@72Hz.

7 Click OK.

8 Restart your system.

Backing up your system 19



Backing up your system

After you have installed the BOS and performed your initial customization
and configuration, it is a good idea to create a system backup. You use a
backup to restore a corrupted file system and recover data. 

You can use the Install Assistant to create a backup after your initial
installation. You can also use the System Management Interface Tool (SMIT)
to make a backup. SMIT uses the mksysb command to create a backup image
that you can store either on a tape or in a file. If you choose to back up to
tape, the backup program writes to the tape a boot image that you can use for
installation on other systems. 

For more information on using SMIT, see Chapter 6 and use InfoExplorer.

Configuring before the backup

Configure your system before you create a backup image if you want the
image to be identical and have the same users, passwords, network addresses,
and so on. However, if you plan to use the backup image to install the BOS on
other Network Servers, create the backup image before configuring the
system. 

If you install the backup image on other systems, you might not want
passwords and network addresses copied. Using the same passwords on many
systems can create a security risk, and copying network addresses creates
duplicate addresses and can disrupt communications.

The BOS installation program automatically installs only the device drivers
required for the hardware configuration of the installed machine. Therefore, if
you are installing a system backup on other machines, you may need to
install additional device drivers on the source system before making the backup
image.

To install additional device support on the source system, use the Install
Additional Device Software menu item in SMIT.
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Creating a backup

Follow the steps in this section to create a system backup. 

1 Log in as root.

2 Mount all file systems you want to back up. 

Refer to the mount command for details.

3 Free at least 8.8 MB of disk space in the /tmp directory or increase the size of your 
disk partition. 

The mksysb command requires this working space. To determine the free
space in the /tmp directory, use the df command. If necessary, use SMIT or
the chfs command to change the size of the file system.

4 Enter the following SMIT command:

smit mksysb

The “Back Up the System” screen appears.

5 Select how you want to store the backup.

Press F4 to list available tape devices. 

6 If you want to create map files, select the Create Map Files field.

Map files match the physical partitions on a drive to its logical partitions.

7 If you want to create a bootable backup, leave the default of yes. If you do not want a
bootable backup, press Tab to change the option to no.

8 Specify if you want to expand the /tmp directory if you have a bootable backup.

9 Specify the number of blocks to write in a single output, or leave the field blank to accept
the system default. 
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10 For a file backup, press Enter. For a tape backup, insert a tape and press Enter.

The Command Status screen appears. 

If you are creating a tape backup, the system may prompt you to insert 
another tape. 

11 When the backup completes, exit SMIT.

The backup is complete. If you created a bootable tape, it can start up your
system if you are ever unable to start it up from the hard disk.

Verifying a backup tape

You can use the procedures in this section to view the contents of a backup
tape. The contents list verifies most of the information on the tape, but it does
not verify that the tape can be used for installations. The only way to verify a
boot image on a tape is to try to start up the system from it.

To verify a backup tape, follow these steps:

1 Enter the following SMIT command:

smit lsmksysb

The “List Files in a System Image” screen appears.

2 Type the number of blocks to read for your tape device, or leave the field blank to accept
the system default.

3 Either type the tape device name in the second field or accept the name provided.

4 Press the Enter key.

The Command Status screen appears listing the contents of the backup tape.
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Installing the BOS from a system backup

You can install the BOS from a tape backup image. 

Installing from a system backup reduces repetitive installation and
configuration tasks. 

When you install a backup image, the system determines if the target system
has enough disk space to create all the logical volumes. If so, the entire
backup is installed. Otherwise, the installation program stops the system and
prompts you to select more destination hard disks.

You can create a backup with SMIT using either the “Back Up the System”
menu or the command mksysb -i TargetDevice. See “Backing Up Your
System,” earlier in this chapter, for more information.

To install from a backup, follow these steps:

1 Put the backup tape in the tape drive.

2 Shut down the system. Enter the command

shutdown -F

3 Turn the front key to the left (service) position.

4 Turn on your computer.

The computer starts up from the backup tape. Follow the instructions in
“Installing the AIX Base Operating System” earlier in this chapter.

WARNING If you are using a backup to configure many systems, make
sure that the backup image was created before the system was
configured with network information and addresses and user accounts
and passwords. Duplicating this information causes network problems
and security risks. If you prefer, you can manually modify this
information on the new system after installation.
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Restoring a corrupted file system

Once you have created a backup, you might need to restore information that is
lost or damaged. 

To restore a file system from a tape backup, follow these steps:  

1 Put the backup tape in the tape drive.

2 Shut down the system. Enter the command

shutdown -F

3 Turn the front key to the left (service) position.

4 Turn on your computer.

The computer starts up from the backup tape. 

A message appears asking you to define the system console.

5 Press F1 and then the Enter key to use the local display as your console.

You need an extended keyboard to identify your console unless you are
installing with a terminal connected to the modem port.

6 When prompted, select  a language for installation instructions.

For English, type 1 and press Enter.

The following message appears on your screen.
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Welcome to the Base Operating System

Installation and Maintenance

Type the number of your choice and press Enter.

Choice is indicated by >>>.

1 Start install now with default settings

2 Change/show installation settings and install

>>> 3 Start maintenance mode for system recovery

88 HELP ?

99 PREVIOUS MENU
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7 Type 3 and press Enter.

A menu appears that lists options for system maintenance.

8 Type 1 and press Enter.

The choice indicated by 1 lets you access a root volume group.

When you choose 1, the system warns you that you might overwrite existing
information and then lists the available volume groups.

9 Type the number of the volume group that you want to restore and press Enter.

A menu appears that lists the file systems on this volume group.

10 Type the number of the file system that you want to restore and press Enter.

Your system lists options for mounting the file system.

11 Select Mount File System and Start Shell.

Your system mounts the file system and provides a shell for you to enter UNIX
commands to examine the file system from the backup and restore
information.

Maintenance

Type the number of your choice and press Enter.

Choice is indicated by >>>.

>>> 1 Access a Root Volume Group

2 Copy a System Dump to Removable Media

3 Access Advanced Maintenance Functions

4 Install from a System Backup

88 HELP ?

99 PREVIOUS MENU
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This chapter describes how to begin and end a work session. It covers the
following topics:

m logging in and out

m rebooting

m shutting down the system

3 System Startup, Logging In, 
Shutting Down, and Rebooting



Before logging in

This manual assumes that the following conditions have been met:

m You have the documentation for your computer and monitor hardware
available and you are acquainted with the use of the hardware and any
necessary peripheral devices.

For detailed information on starting up and shutting down the Network
Server, see Setting Up the Network Server, which was packaged with the
Network Server.

m AIX has been properly installed on the server. If this is not the case, follow
the directions in Chapter 2.

m You have a user account and a password, or, if you are administering the
system, you have root privileges and the root password.

Note: If you have problems booting AIX, consult the chapter “Starting Up
Your Server” in Setting Up the Network Server, where there is a description of
causes of Open Firmware problems and potential solutions. There is also a
description of error messages that might show up on the LCD during the
startup process. 

Logging in

To use the system, you must identify yourself to the system as an authorized
user by logging in with your login name. 

The appearance of the login prompt depends upon whether your system is set
to log in from the command-line interface or from the graphical interface. For
information on setting the system to log in to the graphical interface, see
“Setting Up Your System So That CDE Starts Automatically,” in Chapter 4.

Note: If your login prompt does not appear after you start up the system, see
“System Error Messages” in Chapter 10.
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The login prompt for the command-line interface is

login:

For more information on the graphical interface login window, see the section
“The Graphical Interface Login Window,” later in this chapter.

1 Type your login name following the login: prompt, and press Return.

login: LoginName

If the password: prompt does not appear, you have no password defined,
and you can begin working with the operating system. If the password:
prompt does appear, continue with step 2.

2 Type your password and press Return. 

password: YourPassword

The screen does not display your password as you type it.

If the system displays an error message stating that your login is incorrect, log
in again and enter the correct login name and password. 

Remember that UNIX is case-sensitive. You must enter the login name and
password using the same lowercase or uppercase characters that were used
when the name and password were assigned. Thus, if your login name is
johnson, you will not be able to log in as Johnson.

Note: The root password is also the password for Open Firmware. 

After you have logged in and depending on how your system is set up, your
system will start up in a graphical interface (AIXwindows or Common
Desktop Environment) or in a command-line interface (the shell). 
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The graphical interface login window

The graphical interface login window contains an Options button that allows
you several options. For example, you can change to a command-line login 
as follows:

1 Click the Options button.

2 Choose Command Line Login.

A message tells you to press any key to display the login prompt.

3 Press any key.

The login: prompt appears.

The Options menu also offers the following options:

m Language. Allows you to change the session language.

m Session. Allows you to choose Regular Desktop (the Common Desktop
Environment) or Failsafe session (an X windows environment).

m Reset Login Screen. Restarts the X server.

To delete what you have typed in the Login field, click the Start Over button. 

Shutting down

From the user’s viewpoint, stopping (shutting down) a system is simple, but
from the system’s viewpoint, the shutdown process involves a series of events
designed to preserve file integrity.

The safest and most thorough way to halt the operating system is to use the
shutdown command. When you designate the appropriate command options,
the shutdown command notifies users that the system is about to stop
operations, terminates all existing processes, unmounts file systems, and
shuts down the system.

IMPORTANT If you are shutting down the server to disconnect it from the
network, stop all services that use network services first. If you are shutting
down the server to move it to a different location on the network, you also
need to reconfigure TCP/IP and other network information. You can
reconfigure before or after you move the server.
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The steps that take place during a system shutdown depend on how the
system was customized. The shutdown described in this section may not
appear exactly the same on your system.

Note: You must have root privileges to shut down the system.

To shut down the system, do this:

m At the prompt, type

shutdown

and then press Return.

By default, the system waits one minute before stopping the user processes
and the init process. You see the following message:

shutdown completed... 

Rebooting the system

A system reboot recopies the operating system from disk to memory and starts
it without turning the system completely off. A reboot is also known as a
system reset. It reinitializes the operating system by repeating the initial
program load (IPL) operation. When the system is first turned on, the
operating system is usually booted automatically.

When the -r option is specified with the shutdown command, the system
reboots after it completes the shutdown.

m At the prompt, enter

shutdown -r

The system shuts down and reboots. 

You can also use the reboot command. If no other users are logged into the
system, use the reboot command to cause the system to recognize newly
installed software, to reset peripheral devices, or to perform routine
maintenance tasks, such as checking file systems. 

Use the shutdown command (instead of the reboot command) to warn
other users about the shut down and cleanly quit running processes.
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The steps that take place during a system reboot depend on how the system
was customized. The reboot process described in this section may not be
exactly the same on your system.

Note: You must have root privileges to reboot the system.

m At the prompt, enter

reboot

The system reboots. 

Shutting down to single-user mode

In some cases, you may need to enter single-user mode (also referred to as
maintenance or standalone mode) in order to perform software maintenance
and diagnostics. To shut down the system to single-user mode, the current
directory must be the root directory, and you must have root privileges. 

1 Be sure that you are working in the root directory by entering

cd /

2 Enter

shutdown -m

The system shuts down to single-user mode. A system prompt appears, and
you can perform maintenance activities.

Shutting down quickly

Use the following procedure to stop the system quickly without notifying 
other users. 

m At the prompt, enter

shutdown -F

The -F option instructs the shutdown command to bypass sending messages
to other users and to shut down the system as quickly as possible.
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This chapter describes the use of the AIXwindows interface, which allows
you to manage the aixterm terminal windows and any other X client windows
on your screen. It covers the following topics:

m starting and using the AIXwindows interface

m working with menus in the AIXwindows interface

m manipulating icons

m using the Common Desktop Environment

4 Using AIXwindows and 
the Common Desktop Environment



Introduction to AIXwindows

AIXwindows runs a terminal emulator (aixterm) in a terminal window. The
AIXwindows interface allows you to

m run several programs simultaneously on a single screen

m create multiple windows to meet your specific needs

m cut and paste text between windows

m control various terminal functions

Note: Many of the commands described in this chapter use the Alt key. If
your keyboard does not have an Alt key, use the Option key in its place.

Starting AIXwindows from the command line

When you log in to your system, you start in either the command-line
interface, AIXwindows, or Common Desktop Environment, depending on
how your system is set up. If you start up in the command-line interface, start
AIXwindows by entering the following command:

xinit
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Elements of the AIXwindows interface

When AIXwindows starts, an aixterm terminal window appears that contains
the elements shown in the following illustration: 

The elements of the window are described here:

m Client area. The input and output of the program take place here.

m Resize handles. Point to a resize handle and drag it to change the window size.

m Title bar. The title of the program or other specified information is
displayed.

m Window menu button. Click the window menu button to display the
Window Manager menu.

m Minimize button. Click the minimize button to convert the window to an icon.

m Maximize button. Click the maximize button to expand the window to its
maximum size (often the full screen), or to contract it to its previous size.

Title bar

Window menu button

Resize handle

Client area

Maximize button

Resize handle

Minimize button

Resize handle
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Mouse pointer shapes

When AIXwindows starts, an X-shaped mouse pointer appears at the center
of the screen. The pointer shape changes according to its location. For
example, when the pointer is directly over the root window (the background
behind all windows), the pointer has an X shape. When the mouse points
inside a terminal window, the pointer changes to an I-beam shape. A
description and illustration of pointer shapes follows. 

Arrow pointers

An arrow pointing to the upper-left corner is the general-purpose pointer
used in most window areas for selecting and activating single objects.

An arrow pointing to the upper-right corner indicates a pending menu action.
This shape indicates that a menu is popped up or pulled down and that you
must choose a menu item or release the menu. 

Caution pointer

The caution pointer indicates that some action is expected in another area
before you can give input to the current area. All mouse and keyboard actions
are ignored in the area where the caution pointer appears.
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Four-directional arrow pointer

The four-directional arrow pointer indicates that a move operation is in
progress. During a move operation, the object, or an outline of the object,
tracks the location of the pointer.

Hourglass pointer

The hourglass pointer indicates that an action is in progress in the area. While
the hourglass pointer is active, all mouse and keyboard actions are ignored in
the area. The hourglass pointer and the watch pointer (shown later in this
section) mean the same thing.

I-beam pointer

The I-beam pointer indicates where you can perform actions on the text and
changes the location of the text-insertion cursor. 
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Resize pointer

The resize pointer indicates that the pointer is at one of the resize bars of the
window. The direction of the arrow indicates the direction in which you move
the pointer to increase the size of the window. The horizontal and vertical
pointers indicate that the window is changed in either the horizontal or
vertical direction. The diagonal pointers indicate that the window is changed
in both the horizontal and vertical directions simultaneously.

Sighting pointer

The sighting pointer is used to make precise position selections. For example,
in a drawing program, it may be used to indicate a pixel to fill or the
connecting points of lines.

Watch pointer

See “Hourglass Pointer,” earlier in this section.

X pointer

The X pointer indicates that the pointer is outside any application area. 
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Selecting a window

To activate a window so that it can receive input, do this: 

m Point to any part of the window and click the mouse button. 

The window frame changes color. 

The Window Manager menu

The Window Manager menu (which is often referred to as the window menu)
allows you to perform the most important window-manipulation tasks. 

To display the Window Manager menu, follow these instructions:

m Click the Window Manager menu button (to the left of the window’s title bar) with the
mouse button. You may also press the Shift-Esc or the Alt (or Option)–Space bar key
combination while pressing the left mouse button.

The Window Manager menu contains the following items:

m Restore. Restores a window from an icon or to its previous size.

m Move. Changes the location of the window (see “Moving a Window” later
in this chapter).

m Size. Changes the size of a window (see “Resizing a Window” later in 
this chapter).

m Minimize. Turns the window into an icon.

m Maximize. Enlarges the window to cover the entire root window.

m Lower. Sends a window to the back or bottom of the window stack, the
position closest to the root window. If the window is active, it remains
active until another window is made active.

m Close. Immediately stops the process running in the window and closes 
the window. 

To cancel the Window Manager menu, do this:

m Press Esc (the Escape key).
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Choosing a menu item

To choose a menu item, follow these steps:

1 Display the menu.

2 Hold down the mouse button and drag the pointer down the menu until the item you wish
to choose is highlighted. 

3 Release the mouse button.

You can also press the accelerator keys (shown to the right of the menu items)
without displaying the menu, or you can press the underlined mnemonic
characters with the menu displayed. 

Displaying the root menu

The root menu offers several options for controlling your AIXwindows
interface.

To display the root menu, follow these steps:

1 Point to the root window (the background behind all other windows).

2 Press and hold the right mouse button (or the Right Arrow key).

You can customize the root menu. See the article “Managing AIXwindows
Menus, Mouse Buttons, and Keyboard Bindings” in InfoExplorer (which is
described in Chapter 5). By default, the root menu contains the following
items:

m New Window. Opens a new aixterm window.

m Clients. Opens a submenu that allows you to display a new clock, open the
System Management Interface Tool (SMIT), or lock the screen.

m Custom. Opens the Customizing Tool interface for customizing applications.

m Refresh. Refreshes the screen.

m Pack Icons. Arranges all icons on the screen in one or more neat rows.

m Restart. Restarts the Window Manager.

m End Session. Quits AIXwindows.
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Moving a window

You can move windows using the mouse or the Move item in the Window
Manager menu. 

m Drag the window by its title bar. 

If you prefer, use the following procedure:

1 Choose Move from the Window Manager menu.

2 Point in the window and drag the window to its new position.

3 When the window reaches the new location, press the Return key or click any 
mouse button.

Note: To cancel the move, press Esc before you release the mouse button.

Opening a new terminal window

To open a new terminal window, follow these instructions: 

m Choose the New Window menu item from the root menu.

If you prefer, use the following procedure:

m At the prompt in a window, enter

aixterm&

A new window is displayed, usually 80 characters wide and 25 lines long.
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Bringing a window forward or moving it back

You can use any of three methods for moving a window forward and
backward (on top of or beneath other windows). 

m Click in any visible portion of a window frame. 

If the window is behind other windows, it becomes the active window and
moves to the front. 

m Display the root menu and choose Shuffle Up to move the window at the bottom 
of the window stack to the top, or choose Shuffle Down to move the window at the 
top of the window stack to the bottom.

m Display the Window Manager menu and choose Lower (or press the L key), or press the
Alt (or Option)-F3 key combination. 

The frontmost window moves behind the other windows.

Note: If you use the Lower menu item to move the active window behind 
the other windows, the active window stays active until another window is
made active.

Resizing a window

You can change the size of a window using the mouse, the Window Manager
menu, or a combination of the mouse and keyboard.

1 Point to an edge or corner of the window frame.

2 Drag the edge or corner to increase or decrease the size of the window. 

3 When the window reaches the desired size, release the mouse button.
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If you prefer, use the following procedure:

1 Display the Window Manager menu and choose Size (or press the I key), or press the Alt
(or Option)-F8 key combination. 

A counter appears in the center of the screen, showing the size in characters
of the window as it changes; the outline of a rectangle surrounds the window.
Use the mouse to expand or shrink the window.

2 When the window reaches the desired size, press the Return key, or click any mouse
button.

Note: To cancel the resizing, press Esc before you release the mouse button.

Maximizing a window and restoring it to its previous size

You can maximize a window by expanding it to the full size of the screen.

m Click the maximize button (at the extreme right of the title bar). 

If the window is already maximized, this action returns the window to its
previous size.

If you prefer, use the following procedure:

m Display the Window Manager menu and choose Maximize (or press the X key), or press
the Alt (or Option)-F10 key combination.

To return a window to its previous size, follow this procedure:

m Display the Window Manager menu and choose Restore (or press the R key), or press
the Alt (or Option)-F5 key combination.
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Closing a window

When you quit an application that is running within its own window, the
window usually closes. However, if you must close a window yourself, do 
the following: 

m Double-click the window menu button.

If you prefer, use the following procedure:

m Display the Window Manager menu and choose the Close menu item (or press the S
key), or press the Alt (or Option)-F4 key combination.

Changing windows into icons and restoring windows from icons

To change a window into an icon, do the following: 

m Click the minimize button (on the right side of the title bar, but to the left of the 
maximize button).

If you prefer, use the following procedure:

m Display the Window Manager menu and choose the Minimize menu item (or press the 
N key), or press the Alt (or Option)-F9 key combination.

In either case, the window disappears and its icon appears.

To restore a window from an icon, do this:

m Double-click the icon, or select the icon and press the Alt (or Option)-F5 key
combination.
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Getting help in a window

Various tools are available to help you when you need more information
about commands or about the operating system. 

m The InfoExplorer program, an onscreen hypertext information base, allows
you to display and print items from IBM’s onscreen documentation (see
Chapter 5).

m The help command displays information about basic commands.

m The man command displays information about all commands, subroutines,
and files. 

Using the help command

The help command presents a one-page display of information for new
users. Use this command as follows:

m At the prompt in a terminal window, enter

help

The system displays information as shown in the following figure.
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Exiting and logging out from AIXwindows

Before exiting AIXwindows, stop any programs that are running in terminal
windows. This avoids loss of data.

When you exit a program, the command-line prompt returns to the terminal
window. However, if you started the program automatically or from a menu,
exiting removes the terminal window. 

Choosing Close from the Window Manager menu immediately stops any
program running in the window. Interrupting a program like this may cause it
to lose data. However, you can close the clock or an idle terminal window
(one showing a command-line prompt) with no ill effect. 

To exit AIXwindows, do this: 

m Select End Session in the root menu.

Copying text between windows 

When you have text in a terminal window, the aixterm program allows you
to select text and copy it within the same window or to other windows if the
application that is running in the window supports this feature. 

To copy text from one window into another window, follow these steps:

1 Have the window you want to copy from and the window you plan to copy into open on
your screen.

2 Point to the beginning of the text you want to copy. 

3 Press and hold down the mouse button.

4 Drag the pointer across the text you want to copy and release the mouse button at the
end of the selection. 

While the mouse button is held down, the text to be copied is highlighted.

5 Move the mouse pointer to the window in which you want the copied text to be inserted. 

6 Press the middle mouse button (or the Left Arrow key, if you are using a one-button mouse).

The copied text is inserted at the cursor’s position.
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The aixterm menus

Usually, the aixterm menus are divided into two sections separated by a
horizontal line. The top portion contains various modes that can be toggled
on or off. A checkmark is displayed next to a mode that is currently active.
Choose one of these modes to reverse its state. 

The bottom portion of the menu contains the command entries; choose one
of these to perform the action indicated.

The aixterm Options menu

To display the aixterm Options menu, follow these steps: 

1 With the mouse pointer anywhere inside the window, press and hold down the Control
key and the mouse button. 

2 When the aixterm Options menu appears, release the Control key.

3 While still holding down the mouse button, drag the pointer to the item you want to set or
reset. Then release the mouse button.

For instructions on using this menu, consult the article “Basic aixterm Tasks”
in InfoExplorer. InfoExplorer is described in Chapter 5.

The aixterm Modes menu

To display the aixterm Modes menu, follow these steps: 

1 With the mouse pointer anywhere inside the window, press and hold down the 
Control key and the right mouse button (or the Right Arrow key, if you are using 
a one-button mouse).

2 When the aixterm Modes menu appears, release the Control key.

3 While still holding down the right mouse button (or the Right Arrow key, if you are using
a one-button mouse), drag the pointer to the item you want to set or reset. Then release
the mouse button (or arrow key). 

For instructions on using this menu, consult the article “Basic aixterm Tasks”
in InfoExplorer. InfoExplorer is described in Chapter 5.
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Using the Common Desktop Environment

Help volumes, InfoExplorer information, and IBM’s hard copy manuals may
refer to the Common Desktop Environment (CDE) as AIXwindows Desktop,
Common Desktop Environment desktop, the CDE desktop, CDE, or simply, the
desktop. From this point on, this manual uses the term CDE. 

CDE allows you to access networked devices and tools without having to use
the command line. You can exchange data across applications simply by using
your mouse to drag and drop objects.

For more information on CDE, consult InfoExplorer (described in Chapter 5)
or Common Desktop Environment 1.0 User’s Guide (CDE Documentation
Group, Addison-Wesley Publishing Company, 1995).

Starting CDE from the command line

If you log in from the login window in graphic mode (described in the
section “Logging In” in Chapter 3), CDE starts automatically. If CDE is not
set to start automatically on your system, use the following command to start
CDE from the command-line interface: 

xinit /usr/dt/bin/Xsession

Setting up your system so that CDE starts automatically

You can use any one of three ways to configure your system so that CDE
starts automatically: 

m from the command line

m with the System Management Interface Tool (SMIT)

m with SMIT fastpath

This section tells you how to configure CDE autostart from the command
line. For information on configuring CDE autostart with SMIT or with SMIT
fastpath, use InfoExplorer, described in Chapter 5, to locate the article
“Starting and Stopping the AIX Common Desktop Environment.”
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To configure CDE autostart from the command-line interface, follow 
these steps:

1 Enter the following command:

/usr/dt/bin/dtconfig -e

2 Reboot the machine.

To disable CDE autostart, do this:

1 Enter the following command:

/usr/dt/bin/dtconfig -d

2 Reboot the machine. 

Elements of CDE

The CDE front panel appears. 

The following paragraphs describe the icons displayed along the bottom of 
the desktop.

Calendar

Click the Calendar icon to display a calendar application.

File Manager

Click the File Manager icon to display the File Manager. Use the File
Manager to handle desktop objects (such as files, directories, and application
icons), which you can manipulate without having to remember commands.

Calendar Text Editor
Application
Manager

File Manager

Help
Manager

Mail
Application

Exit

PrintersScreen lock

Workspace
switch button

Style Manager
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Text Editor

Click the Text Editor icon to open a Text Editor window. Click the Help
button in the Text Editor window for information on using Text Editor.

Personal Applications menu

Click the arrow above the Text Editor icon to open the Personal Applications
menu, which contains the following items:

m Install Icon. Adds applications to the front panel. For assistance, click
Install Icon with the right mouse button and select Help.

m Text Editor. Opens a Text Editor window.

m Terminal. Opens a new terminal window.

m Icon Editor. Opens an Icon Editor dialog box. For assistance, click the Help
button in the Icon Editor dialog box.

Mail Application

Click the Mail Application icon to display an application for sending and
receiving mail.

Screen lock

Click the lock icon to lock the screen and display a dialog box that asks for
the user’s password to unlock the screen.

Workspace switch button

Click the numbered buttons to switch between four different screens with
different applications running in each.
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Exit

Click Exit to begin the logout process.

Printers

Click the arrow above the Printers icon to display the Personal Printers menu,
which contains the following items:

m Install Icon

m Default Printer

Style Manager

Click the Style Manager icon to display a dialog box that allows you to
customize the visual appearance or the behavior of your desktop.

Application Manager

Click the Application Manager icon to display the Application Manager,
which contains a variety of action icons that allow you to start applications.
Click the Application Manager Help button for more information.

Help Manager

Click the Help Manager icon to display a window that introduces you to
desktop help. Click the arrow over the Help Manager icon to display the Help
menu. For a description of the menu items, see “Using the Help Menu,” later
in this chapter. 

Opening a terminal window on CDE

The default terminal emulator on CDE is the dtterm window, which is
discussed in the following sections. 
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Opening a dtterm window on CDE

To open a dtterm terminal window on CDE when no terminal windows are
currently open, follow these steps:

1 Click the arrow just above the Text Editor icon at the bottom of the screen.

The Personal Applications pop-up menu appears.

2 Choose Terminal from the pop-up menu.

A dtterm window appears.

If a dtterm window is already displayed, you can use the steps listed above to
open a new dtterm window, or you can do the following:

m Choose New from the Window menu of an existing window.

The dtterm menus are described in the section “Using the dtterm Window,”
later in this chapter.

Opening an aixterm window on CDE

To open an aixterm window on CDE, do the following:

m In a dtterm window, enter

aixterm&
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Using the dtterm window

The dtterm window operates much like the aixterm window, described 
earlier in this chapter. However, the aixterm menus do not operate in dtterm.
Instead, dtterm has a menu bar that allows you to open a Window menu, an
Edit menu, an Options menu, and a Help menu. If the menu bar is not
displayed, you can display it by choosing Toggle Menu Bar from the Window
Manager menu (see the next section, “The dtterm Window Manager Menu”)
or by pressing the right mouse button (or the Right Arrow key, if you are 
using a one-button mouse). 

Like other terminal windows, the dtterm window has a Window Manager
menu, which you display by pressing the Window Manager button at the
upper-left corner of the dtterm window. The illustration shows the Window
Manager button in the menu bar.

The dtterm Window Manager menu

The dtterm Window Manager menu offers the following options: 

m Restore. Restores a maximized screen to its original size. See “Maximize”
later in this list. 

m Move. Allows you to move the window by repositioning the mouse pointer.
End the move by clicking the mouse button. 

m Size. Allows you to resize the window by moving the pointer to the border
you wish to change, then moving the border to its new position. End the
resizing by clicking the mouse button. 

m Minimize. Turns the window into an icon. 

m Maximize. Expands the window to occupy the full screen. Restore it to its
original size by choosing Restore from this menu. 

m Lower. Sends a window to the back or bottom of the window stack, the
position closest to the root window. The window remains active until
another window is made active. 
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m Occupy Workspace. Displays a menu that allows you to display the window
in a workspace other than the one it currently occupies. You can also
choose to replicate the window in all workspaces. See “Workspace Switch
Button” in the section “Elements of CDE” earlier in this chapter.

m Occupy All Workspaces. Replicates the window in all workspaces. See
“Workspace Switch Button” in the section “Elements of CDE” earlier in 
this chapter.

m Unoccupy Workspace. Removes the window from the current workspace if
it occupies more than one workspace.

m Close. Closes the window. Applications running in the window are stopped.

m Toggle Menu Bar. Removes or displays the menu bar.

The dtterm Window menu

The Window menu contains two items:

m New. Opens a new dtterm window.

m Close. Closes the current dtterm window.

The dtterm Edit menu

The Edit menu contains two items:

m Copy. Saves highlighted text to be copied.

m Paste. Places copied text at the cursor position.

The dtterm Options menu

The Options menu contains the following items:

m Menu Bar. Toggles the menu bar on and off. To toggle the menu bar back
on, choose Toggle Menu Bar from the Window Manager menu, or press
the right mouse button (or the Right Arrow key) and choose Menu Bar
from the Options menu. 

m Scroll Bar. Toggles the scroll bar on and off.

m Global Options. Displays the Global Options dialog box. See 
“dtterm Global Options Dialog Box,” next.
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m Terminal Options. Displays the Terminal Options dialog box. See 
“dtterm Terminal Options Dialog Box,” later in this chapter.

m Window Size. Offers the choice of 80 X 24, 132 X 24, or Default.

m Font Size. Offers several window-font sizes.

m Reset. Offers a choice of hard or soft reset.

dtterm Global Options dialog box

Choose Global Options from the dtterm Options menu to display the Global
Options dialog box.

The Global Options dialog box allows you to control the following:

m cursor style and blink rate

m window background color control (normal or inverse)

m smooth scrolling enabled or disabled

m bell type and margin warning
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For additional information, click the Help button at the bottom right of the
dialog box.

dtterm Terminal Options dialog box

Choose Terminal Options from the dtterm Options menu to display the
Terminal Options dialog box. 

The Terminal Options dialog box allows you to control the following:

m Cursor Key Mode. Sets the mode to Normal mode (the default), to move the
cursor in the specified direction, or Application, to generate escape
sequences for an application to use.

m Keypad Mode. Sets the mode to Numeric mode (the default), to display the
numeral corresponding to the key pressed, or Application, to generate
escape sequences for an application to use.

m Newline Sequence. Allows you to choose between Return Only (the default),
which generates a carriage return, and Return/Line Feed, which generates
a line feed and a carriage return.
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m User Function Keys. Locks or unlocks the function keys.

m 132 Column Switching. Disables (the default) or enables 132 column
switching. When 132 column switching is enabled, if an application
switches to 132 columns, the window automatically enlarges to 132
columns. If 132 column switching is disabled, nothing happens if the
application switches to 132 columns.

m End-of-line Wrapping. Enables (the default) or disables wrapping text to the
next line when the end of the line is reached.

m Reverse End-of-line Wrapping. Disables (the default) or enables wrapping a
backspace at the beginning of a line to the previous line.

The Workspace menu

To display the Workspace menu, hold down the right mouse button while the
mouse pointer is on the desktop background. By default, the menu contains
the following items: 

m Shuffle Up. Moves the rearmost window to the top of the stack of windows.

m Shuffle Down. Moves the top window in the stack to the bottom of the stack.

m Minimize/Restore Front Panel. Turns the front panel into an icon or 
restores it.

m Refresh. Refreshes the screen.

m Restart Workspace Manager. Restarts CDE.

m Logout. Displays a Logout Confirmation dialog box, which allows you to
proceed with the logout or to cancel it.
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Using CDE Help

The first time you log in to CDE, a help window introducing the desktop is
displayed that provides quick access to helpful topics. 

m To display information about using desktop menus and controls and other
introductory topics, click the topic “Basic Desktop Skills.” 

m Click the topic “A Quick Tour of the Desktop” for an introductory review of
the types of applications available in the CDE environment.

m Click the topic “How to Get Help” for details about accessing and using
CDE Help.

Accessing CDE topics

You have a number of ways to access CDE Help topics:

m Help key. The quickest and easiest way to get help is to press F1, 
usually known as the Help key. When you press F1, the application you 
are using responds by displaying the help topic most closely related to 
your current activity.

m Help Manager. To access the extensive CDE Help volumes, follow 
these steps:

1 Click the Help Manager icon located on the CDE front panel. 

When you click the Help Manager icon, the Help Manager dialog box
appears, which contains a hypertext-linked list of all the help volumes that
support 
the desktop. 

2 In the Help Manager dialog box, click “Common Desktop Environment (CDE)” to display
the list of help volumes that have been installed on your desktop. 

Browse the list of titles. 

3 To open a volume, click its title. 
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Using the Help menu

To view the Help menu and its available items, click the arrow above the Help
Manager icon.

The Help menu contains the following items:

m Install Icon. Adds applications to the front panel. For assistance, click Install
Icon with the right mouse button (or the Right Arrow key) and select Help.

m Help Manager. Displays the Help Browser help volume, which gives you
access to the installed desktop help volumes on the system.

m Desktop Introduction. Displays the help volume titled “Introducing the CDE
Desktop,” which contains topics covering basic desktop concepts and skills.
This help volume appears automatically the first time a user logs in to
CDE.

m Front Panel Help. Displays the help volume for the front panel; it contains
information on how to use and customize the front panel.

m On Item Help. Changes the pointer to a question mark that you can drag
onto desktop objects for specific information on those objects. 

Special circumstances 

If you need to start applications on a workstation other than your own, and
that workstation is also running the CDE desktop, you may need to do some
configuring on both workstations.

Also, if your CDE desktop has one of the following special configurations,
you may need to change certain Login Manager files before starting CDE:

m Your system console is an ASCII terminal.

m Your system is an X terminal or a host for X terminals.
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This chapter presents an overview of the use of InfoExplorer, IBM’s
information retrieval system. 

This chapter covers the following topics:

m using InfoExplorer’s graphical interface

m using InfoExplorer’s ASCII interface

m navigating through InfoExplorer

m searching by word and phrase

m customizing InfoExplorer
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Introduction to InfoExplorer

The Hypertext Information Base Library contains information on how to use,
manage, and program the AIX operating system and other programming
language software. InfoExplorer allows you to find all information in the
Hypertext Information Base Library, and thus serves as a complete onscreen
information source.

Starting InfoExplorer

You can view InfoExplorer in the InfoExplorer graphical interface or the
InfoExplorer ASCII interface. 

Starting InfoExplorer in graphics mode

There are two ways to start InfoExplorer in graphics mode. If CDE is
displayed, you may do the following:

1 Double-click the Application Manager icon.

2 In the Application Manager window, double-click the Information icon.
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3 In the Application Manager - Information window, double-click the InfoExplorer icon.

If you are working in the command-line interface, do the following:

m Enter the command

info -g 

You can start InfoExplorer from a terminal window in AIXwindows or CDE
as follows:

m Enter the info command.

By default, two windows appear: 

m A navigation window containing, by default, the article  “Topic & Task
Index.” This default can be changed. See “Customizing the InfoExplorer
Graphical Interface,” later in this chapter. 

m A reading window that contains the article “Welcome to the InfoExplorer
Window Interface,” which shows you how to perform basic window
operations. 

The navigation window has two rows of buttons at the bottom of the window
that offer a variety of options for navigating through the information database.

For further information on InfoExplorer in graphics mode, see “Using the
InfoExplorer Graphical Interface,” next. For further information on types 
of windows used by InfoExplorer, see “InfoExplorer Windows,” later in 
this chapter.

For information on starting and using InfoExplorer in ASCII mode, see
“Using the InfoExplorer ASCII Interface,” later in this chapter.

For information on the command options that you can use with the info
command, see “The info Command Options,” later in this chapter.
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Using the InfoExplorer graphical interface

The following paragraphs describe the use of the graphical interface. 

Using InfoExplorer to learn InfoExplorer (graphical interface)

This section offers a quick procedure for displaying Chapter 7, “Accessing
Information With InfoExplorer,” of IBM’s AIX Version 4.1 Getting Started. If
you are planning to use the InfoExplorer ASCII interface, see “Using
InfoExplorer to Learn InfoExplorer (ASCII Interface)” later in this chapter. 

1 Click the List of Books button at the bottom of the navigation window.

The List of Books appears. 

2 In the list headed “Base Operating System Books,” click AIX Version 4.1 Getting Started.

3 Scroll down to Chapter 7.

4 Click the title of the section you wish to consult.

The text is displayed.

5 If you wish to print the article, choose Print from the Info menu (in the menu bar of the
reading window).

Highlighting conventions in InfoExplorer articles

The Hypertext Information Base Library uses the following font and
highlighting conventions: 

m Bold identifies commands, keywords, files, directories, and other items
named by the system.

m Italics identifies parameters for which you supply the names or values.

m Courier identifies examples of specific data values, displayed text, portions
of program code, messages from the system, or information you enter.
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InfoExplorer windows

InfoExplorer uses two basic types of windows: navigation windows and
reading windows.

Navigation windows

Navigation windows help you navigate to the articles containing the information
you want. Navigation windows contain lists of topics with hypertext links.
The hypertext links are enclosed in boxes. They allow you to display articles
on the specific topic. Only one navigation window can be displayed at a time.
The contents of the navigation window are replaced each time you display
another navigation window. 

The buttons at the bottom of the Navigation window are described briefly in
the following table. 
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Button Material displayed

Topic & Task Index A list of tasks and topics grouped by subject area

List of Commands Information on commands listed alphabetically and by functional
categories

List of Books A list of AIX documents available with InfoExplorer 

Programming Reference Programming reference information arranged under major functional
categories that are listed alphabetically

History A list of all InfoExplorer locations accessed since starting
InfoExplorer or clearing the History list

List of Bookmarks A list of bookmarks used to mark places in the InfoExplorer database
for future reference

List of Notes Notes you have made about the information you have accessed

Path The path of your information search through InfoExplorer

Search A simple or a compound search window for entering words and 
phrases and criteria for your search through the database

Reading windows

Reading windows contain conceptual, procedural, or reference information
on a topic. They explain how to perform a task, or they document commands,
calls, subroutines, files, or file formats. You can display more than one
reading window at a time (with the Hold button), or you can have the
contents of the window replaced each time you select more information. 

You can click the following buttons that appear at the bottom of a reading
window in order to perform the actions indicated:

m Make Note. Creates a note and places a note icon in the text. Click the Up
Arrow button to jump to the previous note; click the Down Arrow button
to jump to the next note.

m Make Bookmark. Creates a bookmark in the text. Click the Up Arrow button
to jump to the previous bookmark; click the Down Arrow button to jump to
the next bookmark (if you have previously loaded a list of bookmarks).
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m Path. Displays your path list. You can jump to any article in your path list,
or you can clear or modify the path list. Click the Up Arrow button to
jump to the previous item; click the Down Arrow button to jump to the
next item on your path list. 

m Search. Searches the InfoExplorer or other databases for specific terms 
or phrases. 

At the top of the window, there are three buttons that you can click to activate
reading window functions:

m Hide Links. Alters the text so no links show. To hide links, click the Hide
Links button. To show all links, release the Hide Link button by clicking 
it again.

m Hold. Opens an article in a new window without replacing the original
article.

m Close. Closes the reading window. 
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Using InfoExplorer graphical interface help

From an InfoExplorer window, you can view help information about the
functions and options available for the current window, or you can search
through a list of topics for the appropriate help information.

Displaying help for a specific window

The Help menu in each window contains an On Window item, which
displays an article describing the function, menus, and buttons that are
available in the current window.

To display help for a window, follow these steps:

1 Click Help in the menu bar to display the Help menu.

2 Choose On Window.

A help article opens in a new reading window.

Getting Help from the “List of Helps”

The Help menu in each InfoExplorer window contains a “List of Helps” item,
which displays a list of InfoExplorer help topics. The help articles display the
information and procedures for a wide range of tasks.

To use the “List of Helps,” follow these steps:

1 Click Help in the menu bar to display the Help menu.

2 Choose “List of Helps.”

3 Click the desired help topic.
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Searching for information 

InfoExplorer allows you to look for information by word or phrase. This type
of search looks through the entire text of the hypertext information base. For
example, you can search for information even if you do not know a task or
command name under which the information is stored. 

You can perform a simple search or a compound search. The simple search
allows you to search using a word or string of words (in exact order) in text,
article titles, or both. The compound search allows you to search using a word,
set of words, or several sets of words. Moreover, the compound search allows
you to specify the search with the following options:

m And, Or, and But Not operators

m proximity options

m search categories

m precedence

Specifying the databases to search

There are two ways to specify the information databases to be searched:

m Select a temporary information database in the Compound Search window.
This selection applies to both simple and compound searches and stays in
effect for the current session of InfoExplorer or until you change the
selection during the session.

m Select a default information database by choosing Defaults from the
Options menu (see “Customizing the InfoExplorer Graphical Interface”
later in this chapter). This default information database applies to both
simple and compound searches and stays in effect for future sessions of
InfoExplorer. Temporary information database selections made from the
Compound Search dialog box can override the default selection during 
an InfoExplorer session, but the default selection returns when you restart
InfoExplorer.
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The simple search

You can perform a simple search as follows: 

1 Click the Search button at the bottom of the navigation window.

The Simple Search dialog box appears.

2 Type the phrase for which you are searching in the Search For field and press Return.

A list of articles on the simple search appears.

If you wish to print the article, choose Print from the “info” menu.

For an onscreen tutorial about performing a simple search, follow the directions
in “Using InfoExplorer to Learn InfoExplorer (Graphical Interface),” earlier
in this chapter, to find the section “Searching for Information (InfoExplorer
Windows)” in Chapter 7 of IBM’s AIX Version 4.1 Getting Started.

The compound search

If the Simple Search dialog box appears when you click the Search button in
the navigation window, click the Compound Search button at the bottom right
of the Simple Search dialog box. The Compound Search dialog box appears. 
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This dialog box allows you to enter four text strings. You can specify 
the following:

m The buttons along the left of the last three text boxes allow you to choose
the And, Or, or But Not operator. 

m You may specify whether the strings should appear in the same article 
or paragraph. 

m You may specify how far apart they must be within a paragraph. 

m You may choose the databases, categories, and fields in which they 
must appear.

For more information about compound searches, do a simple search to find
the InfoExplorer articles “How to Perform a Compound Search (InfoExplorer
Windows)” and “The Compound Search Window.” The simple search is
described in this chapter in the previous section. 
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Printing from the InfoExplorer graphical interface

You can print the following information from the InfoExplorer 
graphical interface: 

m articles from a reading window

m all articles referred to by a navigation window

m artwork displayed in a graphic window

m public and private notes

For detailed information on printing, follow the directions in “Using
InfoExplorer to Learn InfoExplorer (Graphical Interface),” earlier in this
chapter, to find the section “Printing Information (InfoExplorer Windows)” 
in Chapter 7 of IBM’s AIX Version 4.1 Getting Started.

Keys and keystroke sequences for the InfoExplorer 
graphical interface

In the InfoExplorer graphical interface, you can use special keys and key
sequences to move within a window, choose items from a menu, access
additional windows, and start processes. 

For detailed information, follow the directions in “Using InfoExplorer to
Learn InfoExplorer (Graphical Interface),” earlier in this chapter, to find the
section “Using Special Keys and Key Sequences (InfoExplorer Windows)” in
Chapter 7 of IBM’s AIX Version 4.1 Getting Started.

Stopping InfoExplorer

You can stop the InfoExplorer program from any open InfoExplorer window. 

To exit the InfoExplorer program and save all bookmarks and notes:

m Choose Quit from the “info” menu in any InfoExplorer window. 

All open windows are closed and the program is exited.

To exit the InfoExplorer program without saving all bookmarks and notes:

m Choose Close from the navigation window menu located to the left of the title bar.

All open windows are closed and the program is exited.
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Customizing the InfoExplorer graphical interface

The Options menu in the navigation window allows you to reset 
InfoExplorer defaults. 

1 Choose Defaults from the Options menu (in the navigation window’s menu bar).

The Defaults Editor dialog box appears.

2 To change the default search databases, click the button below the Default Search
Databases option; to change the default navigation article, click the button below the
Default Navigation Article option.

3 Click the appropriate item in the list that appears. 

4 Click the Save button. 
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Using the InfoExplorer ASCII interface

This section introduces the InfoExplorer program ASCII interface. Since
InfoExplorer information is hypertext, you view the information on your
computer screen and select links to move from one article to another. Thus
you can choose your own path through the hypertext documentation. 

Starting InfoExplorer in ASCII mode

To start InfoExplorer in ASCII mode, follow these instructions: 

m Enter the  command

info -a

A navigation screen appears that is, by default, the Topic & Task Index screen.
To change this default, see “Customizing the InfoExplorer ASCII Interface”
later in this chapter. The navigation screen displays lists of topics that contain
hypertext links to pertinent articles. The articles are displayed in a reading
screen. For more information on navigation screens and reading screens, see
“InfoExplorer ASCII Screens” later in this chapter.

Using InfoExplorer to learn InfoExplorer (ASCII interface)

This section offers a quick procedure for displaying Chapter 7, “Accessing
Information With InfoExplorer,” of IBM’s AIX Version 4.1 Getting Started.

1 Press Control-O to activate the menu bar.

2 Use the Left and RIght Arrow keys (or press D) to highlight Display in the menu bar; then
press Return.

3 Use the Down Arrow key to highlight “List of Books” in the Display menu.

4 Use the Tab key to highlight AIX 4.1 Getting Started; then press Return.

5 Use the Tab key to highlight the section you wish to consult.

6 Press Return to display the information.
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To print the article, follow these steps:

1 Press Control-O to activate the menu bar.

2 Press I to highlight “info” and press Return to display the menu.

3 Use the Down Arrow key to highlight Print Article; then press Return.

InfoExplorer ASCII screens

In the InfoExplorer ASCII interface, different screens contain different types
of information. For example, you use some screens specifically for moving
through the information database. These screens, which include the Topic &
Task Index and the Books, are navigation screens. The InfoExplorer program
displays one navigation screen at a time. The contents of this screen are
replaced each time you select a function that displays its information in this
location.

The screen that contains the text you want to read is called the reading screen.
When you do an information search, the navigation screen becomes the
reading screen. Reading screens provide conceptual, procedural, or reference
information. They display articles that teach you about a topic, explain how to
do something, or provide you with information about commands, calls,
subroutines, files, or file formats.
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The reading screen

When you start the InfoExplorer ASCII interface for the first time, the first
screen that appears is the reading screen, containing the document “Welcome
to the InfoExplorer ASCII Interface.” The reading screen contains procedural,
conceptual, and reference information. The first line of the screen displays
the menu options, and the second line displays a title bar. The phrase “info
Document” appears at the right end of the title bar. 

Only one reading screen is available at a time. Each time you select a link to
another article, the contents of the article you select replace the contents of
the original article. 
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The navigation screen

The navigation screen is the starting point for finding documentation about
the operating system and other programs available on your system.
Information is organized by topic and task, by book, or alphabetically by
commands or programming reference items. 

The first line of the screen contains the menu bar; the second line displays a
title bar that displays the title of the screen. In the figure below, the second 
line informs you that the title is Topic & Task Index and that this is a
navigation screen.

Note: The navigation information in this section applies to the InfoExplorer
program that is shipped with your operating system. The navigation
information may not apply to other libraries.

While you are viewing the InfoExplorer program through the ASCII interface,
only one navigation screen is available at a time. Each time you select a link
to another navigation article, the contents of the article you select replace the
contents of the original article. For information on selecting links, see
“Selecting an ASCII Hypertext Link” later in this chapter.
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Moving between the screens

To return to the navigation screen from the reading screen (or to go back to
the reading screen from the navigation screen), press Control-W. 

Selecting an ASCII hypertext link

Items that are underscored in navigation screens or reading screens are
hypertext links; the currently selected link is highlighted. 

To follow a link to more information, follow these steps:

1 Press the Tab key (or Control-F) to move from one link to the next. 
Press Control-B to move back to the previous link.

2 Press the Return key to display the linked information.

Getting help

You can display the Help menu as follows: 

1 Press Control-O to activate the menu bar at the top of the screen.

2 Use the Left and Right Arrow keys (or press H) to highlight the menu title Help.

3 Press Return. 

You can then choose between the following items:

m This Window. Displays specific help information for the screen you are
viewing, including the following:
—links to articles that describe the screen
—functions available from that screen
—a list of menus available in the screen
—links to descriptions of the menu items

You can select links to display information that you want to read. To 
return to the help information screen after selecting a link, use the Path or
History menu in the menu bar. See “Returning to a Previous Location” 
later in this chapter.

m List of Helps. Displays a list of hypertext links to articles that describe key
aspects of the InfoExplorer program and documentation, along with links
to the individual help screens. 
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Scrolling information in ASCII screens

You can move forward or backward through text displayed in either the
navigation screen or the reading screen by using the following keys and key
sequences. 

Move Keystroke

Previous page Page Up key or Control-P

Next page Page Down key or Control-N

Cursor up one line Up Arrow 

Cursor down one line Down Arrow

Choosing an ASCII menu item

Each InfoExplorer screen contains a menu bar across the top of the screen. To
choose a menu item, do the following: 

1 Press Control-O to activate the menu bar.

2 Use the Left and Right Arrow keys (or type the initial letter of the menu title) to highlight
the title of the menu you want to display; then press Return. Or type the underlined
character in the menu title.

The menu is displayed as a pull-down panel with several items.

3 Use the Up Arrow and Down Arrow keys to highlight a menu item (or type the underlined
character in the desired menu item); then press Return.

The item you choose is invoked, or another menu is displayed. 

To remove a menu without choosing an item, press Control-O. The cursor
returns to the screen.
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Returning to a previous location

During the InfoExplorer session, the InfoExplorer program keeps two
different records of where you have previously been: the History List and the
Path List. These lists enable you to return to previous locations in the
information database.

History List

The History List records every location that you have displayed in the
information database during the current InfoExplorer session. To view the
History List, do the following:

1 Activate the menu bar by pressing Control-O (if it is not already activated).

2 Use the Left Arrow and Right Arrow keys (or press the period key) to highlight .History;
then press Return.

The History menu is displayed.

3 Use the Up Arrow and Down Arrow keys to highlight the List All item; then press Return.

4 Use the Left Arrow and Right Arrow keys to highlight the location to which you wish 
to return.

5 Press Control-O to activate the menu bar.

6 Goto in the menu bar should be highlighted. If it isn’t, highlight it. Then press Return.

Path List

The Path List keeps track of your current navigation route starting with a
primary navigation screen (Topic & Task Index, Books, Commands, or
Programming Reference). Every time you return to a primary navigation
screen, your previous path list is overwritten.

The Path menu contains three options: 

m Show List. Displays the path list.

m Previous. Jumps to the previous location without displaying the path list.

m Next. Jumps to the next location without displaying the path list.
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To return to a previous location in the InfoExplorer program, follow 
these steps: 

1 Activate the menu bar by pressing Control-O.

2 Use the Left Arrow and Right Arrow keys (or type P); then press Return to display the
Path menu.

3 Use the Up Arrow and Down Arrow keys (or type S); then press Return to display the
Path List. 

A pop-up box displays a list of locations in the path. If you are in a primary
navigation screen, you receive a message stating that the Path List is empty.

4 Use the Up Arrow and Down Arrow keys to highlight the location to which you want 
to return.

5 Press Control-O to activate the menu bar.

6 Highlight Goto in the menu bar and press Return.

The text appears in the reading screen.

Finding information via the primary navigation routes

To display the primary navigation routes in the navigation screen, follow 
these steps: 

1 Press Control-O to activate the menu bar.

2 Use the Left Arrow and Right Arrow keys (or press D) to highlight Display.

3 Press Return to display the menu, which offers the following choices:

m Task (the Topic & Task Index). Displays information by task. This is the
default navigation article.

m Commands. Displays an alphabetical list of available commands.

m Books. Displays a list of articles arranged as though in hard-copy book form.

m Programming Reference. Displays lists of programming functions in
alphabetical order by functional categories.
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Searching by word and phrase

If you do not know what a task or command is, or in which book the
information resides, use the search facility to search the InfoExplorer
information database.

Two types of searches are available in InfoExplorer: the simple search and the
compound search. 

The simple search allows you to use a word or string of characters (in exact
order) to search through text, article titles, or both. In the ASCII version of
InfoExplorer, the Article Title item on the Search menu lets you perform a
simple search of article titles. 

The compound search allows you to search using a word, a set of words, 
or several sets of words. You can further specify the search with the 
following options: 

m And, Or, and But Not operators

m proximity options

m search categories

You can also specify the information databases to be searched for both simple
and compound searches. There are two ways to specify an information
database:

m You can select a temporary information database in the Compound Search
dialog box. This selection applies to both simple and compound searches
and stays in effect for the current session of InfoExplorer or until you
change the selection during the session.

m You can select an information database as a default by choosing Defaults
from the “info” menu and selecting DBselect. This default information
database applies to both simple and compound searches, and stays in effect
for future sessions of InfoExplorer. 

Temporary information database selections made in the Compound Search
dialog box can override the default selection during an InfoExplorer
session, but the default selection returns when you restart InfoExplorer.
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The simple search

You can perform a simple search as follows: 

1 Press Control-O to activate the menu bar.

2 Use the Left and Right Arrow keys (or press S) to highlight Search; then press Return.

3 Use the Up and Down Arrow keys to highlight Simple in the Search menu; then 
press Return.

The Simple Search dialog box appears.

4 Type the word or phrase you are searching for in the Find field; then press Return.

A list of articles appears.

For an onscreen tutorial about performing a simple search, follow the
directions in “Using InfoExplorer to Learn InfoExplorer (ASCII Interface),”
earlier in this chapter, to consult “Searching for Information (ASCII
Interface)” in Chapter 7 of AIX Version 4.1 Getting Started.
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The compound search

You can perform a compound search as follows: 

1 Press Control-O to activate the menu bar.

2 Use the Left Arrow and Right Arrow keys (or press S) to highlight Search; then 
press Return.

3 Use the Up Arrow and Down Arrow keys to highlight Compound; then press Return.

The dialog box for doing a compound search appears.

Press the Tab key to move from field to field; in the highlighted fields, press
the arrow keys to display the available choices.

The Find field allows you to specify three text strings and three operators
(And, Or, But Not) to relate those strings to one another in the order in which
they are displayed in the dialog box. For more information, see the
InfoExplorer article “Narrowing or Broadening a Compound Search.”

The Within field allows you to designate the proximity of the specified 
text strings (within the same article; within 10, 50, or 100 words of the 
same paragraph).

The Search field allows you to specify the kind of text searched (in the first
field) and where in the database to perform the search (in the second field,
following the word “in”).

4 Press Control-O to activate the menu bar.
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5 Choose Search to proceed with the search.

A search match list appears.

6 Use the Up Arrow and Down Arrow keys to highlight the appropriate item; then press
Return. To list all hits in all sources, press Control-O to activate the menu bar; then, with
Goto highlighted, press Return.

A list of sources and the number of hits in each source appears. 

7 Use the Up Arrow and Down Arrow keys to highlight the appropriate item; then 
press Return.

The appropriate information appears in a reading window.

For a more detailed description of the compound search, see the InfoExplorer
article “How to Perform a Compound Search (ASCII).”

Printing from the InfoExplorer ASCII interface

Follow the directions in “Using InfoExplorer to Learn InfoExplorer (ASCII
Interface),” earlier in this chapter, to consult “Printing Information (ASCII
Interface)” in Chapter 7 of AIX Version 4.1 Getting Started.
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Keystrokes used in the InfoExplorer ASCII interface

Different keys and key sequences are active depending on whether you are
working in a text area, a menu bar, or a pop-up screen. 

Keystrokes used in text areas

Keys Action

Control-W Toggles between the navigation screen and the reading screen

Control-F or Tab Moves to the next hypertext link

Control-B Moves to the previous hypertext link

Return or Enter Activates an operation

Control-L Refreshes the screen

Control-N or Page Down Scrolls vertically to the next page

Control-P or Page Up Scrolls vertically to the previous page

Left Arrow Moves the text cursor one character to the left

Right Arrow Moves the text cursor one character to the right

Up Arrow Moves the text cursor up one line

Down Arrow Moves the text cursor down one line

< Moves the text cursor 20 characters to the left

> Moves the text cursor 20 characters to the right

Note: The Left Arrow and Right Arrow keys do not function for the
InfoExplorer program on WYSE terminals.

Keystrokes used in menu bars

Keys Action

Control-O Toggles to make the menu bar active or inactive

Esc or Control-O Closes a pull-down menu and places the cursor in the text area

Tab Highlights the next menu in the menu bar. In pop-up screen menu
bars, moves the cursor from the menu bar into the text area if no 
pull-down menus are currently highlighted.

Left Arrow Highlights the previous option. If a pull-down menu is displayed, the
previous menu title is highlighted and its pull-down menu is displayed.
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Keystrokes used in menu bars (continued)

Keys Action

Right Arrow Highlights the next menu. If a pull-down menu is displayed, the next
menu title is highlighted and its pull-down menu is displayed.

Up Arrow Displays the pull-down menu for the highlighted menu title or highlights
the previous item in a pull-down menu

Down Arrow Displays the pull-down menu for the highlighted menu title or highlights
the next item in a pull-down menu

Return or Enter Activates the operation of the highlighted menu item

In some cases, the menu bar within a pop-up screen contains options that
start or stop a process. The following keys can also be used to move within a 
pop-up screen or to cycle through options in the screen.

Keys Action

Tab Moves to the next field

Left Arrow Moves to the previous option in a group of options

Right Arrow Moves to the next option in a group of options

Space bar Cycles through the options in a group of options

Up Arrow Highlights the previous item in a list

Down Arrow Highlights the next item in a list

Return or Enter Activates the operation of the highlighted item, or ends text entry and 
goes back to the first field

Stopping the InfoExplorer ASCII program

You can leave the InfoExplorer program from either the navigation screen or
the reading screen. 

1 Activate the menu bar by pressing the Control-O key sequence.

2 Use the Left Arrow and Right Arrow keys (or press E) to highlight Exit, then press Return.

The Exit menu appears.

3 Choose the Confirm option by pressing Return. 

The operating system command prompt appears and the InfoExplorer 
program stops.
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Customizing the InfoExplorer ASCII interface

You can change the defaults for the following items of the InfoExplorer 
ASCII interface: 

m navigation window article

m history, notes, and bookmark files

m printers

To change the defaults, follow these steps:

1 In the navigation window, activate the menu bar by pressing Control-O.

2 Use the Left Arrow and Right Arrow keys (or press i) to highlight “info”; then press Return.

3 Use the Up Arrow and Down Arrow keys to highlight Defaults; then press Return.

Use the dialog box that is displayed to change the default navigation article.
Move the cursor into the Navigation Article field and press the arrow keys to
display the available options for the default navigation article.

To edit the printer fields, move the cursor into the appropriate Printer field
and edit the existing text.

To set the default Bookmark, History, and Notes fields, choose from the file
lists in the Bookmarks, History, and Notes items in the menu bar of the
Defaults screen. For further information, see the InfoExplorer article “How to
Set Defaults.”

4 From the menu bar in the Defaults screen, choose Save to save the changes; choose
Reset to delete the changes.
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The info command options

You can use the info command with the items listed in the table. 

Option Function

-a Starts InfoExplorer ASCII version.

-display host:number Specifies the display host.

-f isofonts Specifies for text to be displayed in ISO fonts.

-g Forces the window version of InfoExplorer to run on the default 
display or the display specified by the -display option.

-h string Specifies a term that is used to search for a command article or 
content list for a specified topic or task.

-help Displays the usage message.

-hlc color Specifies the color for hypertext links.

-iconic Starts InfoExplorer with the navigation window icon on the 
desktop. After the icon is opened, all application windows 
open normally.

-l libname Specifies which database library InfoExplorer opens.

-msh N Specifies the maximum number for search hits.

-n [ti | bl | cl | pr | [1–8] ]
Specifies the alphabetic abbreviation or the numeric value 
identifying which primary navigation article is displayed.

-q Starts InfoExplorer quickly without displaying the copyright notice 
and the InfoExplorer “Welcome” article.

-s term Specifies a term or phrase that is immediately used in a 
simple search.

-shc color Specifies the color for search hits.

-t string Specifies a term or phrase that is immediately used in a 
title search.

-tags Sets the debug environment switch enabling the inclusion of the 
Tags menu in the Preferences window menu bar.

-txc color Specifies the color for article text. 
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This chapter describes the following tools that provide special interfaces for
handling system administration tasks:

m Visual System Management (VSM)

m System Management Interface Tool (SMIT)

6 Using System Administration Tools



Visual System Management

Visual System Management (VSM) is a graphical interface that enables you to
perform installation and system management tasks through direct
manipulation of icons. For example, you can delete a user by dragging the
User icon to the Trash Can icon. In addition to performing basic tasks, you
can create new objects from system-defined or user-defined templates; sort,
filter, and find objects; and display the objects in a variety of views. 

Starting VSM applications

You can start VSM applications from CDE or from the command line.  

Starting VSM from CDE

Start VSM from CDE as follows:

1 From the front panel, click the Application Manager icon.

The Application Manager window appears.
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2 Double-click the System_Admin icon.

This displays the Application_Manager–System_Admin window.

3 Double-click the desired application icon.
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Starting VSM from the command line

You can start the following VSM applications from the command line of a
terminal window with the commands listed.

Application name Command

Device Manager xdevicem

Easy Install xinstallm -ez

Install Manager xinstallm

Maintain Software xmaintm

Print Manager xprintm

Storage Manager xlvm

Users & Groups Manager xuserm

The VSM interface 

The features common to many VSM application windows are described in
this section. 

As an example, the Storage Manager window is illustrated.

Most VSM applications contain a work area that contains panes and wells, an
area that contains actions, and an information area. For more information
about how to work in a specific VSM application, read the help text in the
information area, or click the Help button to start the Help System.

Work area panes and wells

The work area is organized into panes containing icons that represent specific
related functions or objects. You can double-click some of these icons that
contain related objects to display a well (or wells). The well displays the
related objects. Double-clicking an object that cannot be expanded brings up
a notebook (dialog box) displaying the object’s attributes. For information on
working with objects, refer to the help in the information area. 

94 Chapter 6 / Using System Administration Tools



Actions—dragging and dropping

The icons in the area labeled “Actions” represent various actions that you can
perform on the objects in the panes and wells of the work area. Perform these
actions by moving the mouse pointer to the action, pressing the middle mouse
button (or the Left Arrow key), and dragging the action icon to the
appropriate object on which you wish to perform the action. This is referred
to as dragging and dropping. 

VSM dialog boxes

Dialog boxes appear if the system requires additional information for
completing a task. For more information about dialog boxes, select the Help
button in a dialog box. For information about the fields and buttons in a
dialog box, click the question mark (?) button at the bottom of the dialog box. 

Click to collapse area

Actions: Drag and 
drop onto objects to
perform actions

Work area panes

Work area well:
Double-click to open

Information area
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Information area

The information area displays a brief description of the object or area at
which the mouse pointer is located. See the next section, “Getting Help in
VSM.” 

Getting help in VSM

All information about the application and how to use it is available on screen.
Use the following methods to access help in the interface.  

Information area

The information area, which is at the bottom of the dialog box, provides
context-sensitive help based on the position of the cursor. The description
provided is often accompanied by an explanation of the task you can perform. 

Dragging and dropping the Item Help (?) action icon

Use the middle mouse button (or the Left Arrow key) to drag and drop the
Item Help (?) action icon on a target to open a Help System window that
takes you directly to the help for that target. Use the Item Help (?) action icon
to learn more about a specific object or area. For more detailed information
about the concepts discussed in the help screens, see the AIX Version 4.1
System Management Guide: Operating System and Devices.

? and Help buttons in a dialog box window

The question mark (?) button in a dialog box opens a help window that
provides context-sensitive help for the highlighted field in the dialog box. The
Help button opens the Help System window displaying the help topic for
dialog boxes.

Help button in a message window

The Help button in a message window provides more information about 
the message. 
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VSM applications

The following sections describe how to use the available VSM applications.
Start these applications by double-clicking their icons in the
Application_Manager–System_Admin window or by entering a command, if
available, at the command line. 

Device Manager

Double-click the Device Manager icon (or enter xdevicem at the command
line) to display the Device Manager dialog box. 

Device Manager displays system objects and dialog boxes that repesent the
contents of your system’s Device Configuration database. This enables you to
manage some devices not covered by SMIT, such as graphic adapters, graphic
display subsystems, ports, buses, expansion drawers, non-SCSI adapters,
standard adapters, and memory cards. The Show Tree View button (at the
bottom left of the dialog box) allows you to view how the devices are
interconnected. 

Device Manager does not include the following SMIT functions:

m trace devices

m printer subsystem management (including virtual printers)

m communications applications and services

m LFT devices: keyboard, displays, fonts, speakers

m Xstation configuration

Easy Install

Double-click the Easy Install icon (or enter xinstallm -ez at the command
line) to display the Easy Install dialog box, which allows you to install software.
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Install Assistant

Double-click the Install Assistant icon to display the Install Assistant dialog
box. 

This dialog box offers an interface for performing the following tasks:

m setting the date and time and the root password

m configuring network communications

m managing system storage, paging space, and the language environment

m creating user accounts

m defining printers

m importing existing volume groups

m installing software applications

m backing up the system

Install Manager

Double-click the Install Manager icon (or enter xinstallm at the command
line) to display the Install Manager dialog box. 

This dialog box allows you to perform the following tasks:

m installing and updating software products

m creating bundles

m defining installation settings

Maintain Software

Double-click the Maintain Software icon (or enter xmaintm at the command
line) to display the Maintain Installed Software dialog box. 

This dialog box allows you to perform the following tasks:

m commit to a software update and automatically remove all previous
versions

m reject an applied update, remove the updated files, and revert to a previous
version of the software

m verify the correctness of the installed software
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Print Manager

Double-click the Print Manager icon (or enter xprintm at the command line)
to display the Print Manager dialog box. 

This dialog box enables you to perform basic SMIT tasks on printers and
queues and is designed to make creating queues much simpler. In addition, it
provides a graphical representation of queue and printer attachments as well
as print jobs waiting in the queue.

Print Manager does not include the following SMIT functions:

m starting a print job

m scheduling jobs

Storage Manager

Double-click the Storage Manager icon (or enter xlvm at the command line)
to display the Storage Manager dialog box. 

This dialog box enables you to manage physical volumes, volume groups,
logical volumes, and file systems through direct manipulation. In addition,
Storage Manager provides an easy way to view the contents of a logical volume.

Users & Groups Manager

Double-click the Users & Groups icon (or enter xuserm at the command
line) to display the Users & Groups Manager dialog box. 

This dialog box simplifies adding users by providing system-defined and user-
customized templates. Simple drag-and-drop actions enable you to set user
passwords, change a user's language, and specify whether or not a user can
log in to a system. 
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VSM keyboard basics

You can perform many of the mouse actions by using various key sequences,
even though the help windows always refer to mouse actions. For a
description, use InfoExplorer to consult “VSM Keyboard Basics” in Chapter 6
of IBM’s AIX Version 4.1 Getting Started.

For a description of InfoExplorer, see Chapter 5 of this manual. For a
summary of commands for accessing AIX Version 4.1 Getting Started, see
the section “Using InfoExplorer to Learn InfoExplorer (Graphical Interface)”
or “Using InfoExplorer to Learn InfoExplorer (ASCII Interface),” both in
Chapter 5 of this manual.

IMPORTANT Set the keyboardFocusPolicy resource in your .Xdefaults
file to explicit so that you can set the input focus using key sequences.
When using the keyboard, the focus area is emphasized. Generally, a focus
area can be selected or serve as a drop site.

The following explains how to use key sequences in place of a mouse:

m Point: Press Tab (forward) or Shift-Tab (backward) to move between areas.
Use the arrow keys to move from object to object in an area. The focus
area is emphasized.

m Click or select: Press the Space bar. A selected object appears with a white
background outlined in black.

m Double-click: Quickly press the Space bar twice.

m Drag and drop: If the phrase is “drag and drop on a target,” select the target
object. If the phrase is “drag and drop in an area,” select an object; then
select the target area and press the Insert key.

m Multiselect: To multiselect, select an object; then use the arrow keys to
point to another object and press Shift–Space bar. Continue until you have
selected all the desired objects in the area. You can select all by pressing
Control-/ and deselect by pressing Control-\.

m Choose: Point to an object or area and press Shift-F10 to view a pop-up 
menu. Use the arrow keys to move from item to item. Press the Space bar 
or Return to select the item. Or you can select an item by pressing its
mnemonic (underlined character). Pressing the Esc key cancels the 
pop-up menu.
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The following tables contain default key sequences you can use in VSM.

Default key mappings for managing the VSM interface

Key Function

Space bar Selects an object

Shift–Space bar Multiselects objects

Control-/ Selects all objects

Control-\ Deselects all objects

Insert Drops a selected object in a selected area

Tab Moves the focus from area to area

Shift-Tab Moves the focus backward from area to area

Arrow keys Moves the focus from object to object in an area

F1 ? Item Help action for selected object

F2 Sort Display control for selected area

F3 Find Display control for selected area

F4 Filter Display control for selected area

F5 Large Icon View control for selected area

F6 Small Icon View control for selected area

Delete Trash action on selected object

Control-Backspace Notebook action on selected object

Default key mappings for managing the help window

Key Function

F1 Provides help on using the help window

F10 Moves the focus back and forth between the read window and the 
menu bar in the Help System window

Control-K Opens a Keyword Search window displaying a help index

Control-B Backtracks to the previous help topic

Control-U Goes up one level in the topic hierarchy

Control-H Returns to the home topic
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Default key mappings for managing the windows

Key Function

Alt-F3 Lower

Alt-F4 Close

Alt-F5 Restore

Alt-F6 Moves the input focus from window to window within the VSM application

Alt-Shift-F6 Moves the input focus to the previous window within the VSM application

Alt-F7 Move

Alt-F8 Size

Alt-F9 Minimize

Alt-F10 Maximize

Alt-Tab Raises the next window in the stack and moves the input focus to that window

Alt-Shift-Tab Raises the previous window in the stack and moves the input focus to 
that window

Alt-Esc Raises the next window in the stack without changing the input focus

Alt-Shift-Esc Raises the previous window in the stack without changing the input focus 

Using the System Management Interface Tool (SMIT)

You can use the System Management Interface Tool (SMIT) to perform
system administration. SMIT provides a task-oriented interface to use the
commands required to manage your system. SMIT menus and dialog boxes
let you quickly create administration commands and free you from the details
of complex command syntax. SMIT also creates log files that you can use to
duplicate system configuration or learn about specific commands. 

Note: Other system management tools are available. You can use the Disk
Management Utility for logical volume management or the Visual System
Management (VSM) applications.

102 Chapter 6 / Using System Administration Tools



You can use SMIT to help start the installation process and install optional
software, as well as manage the following:

m users and groups 

m system environment, performance, and problems

m storage and file systems

m printers, terminals, and tape drives

m print jobs and print queues 

m networks 

For information about SMIT, see the System Management Guide: Operating
System and Devices available through InfoExplorer.
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This chapter describes AppleTalk and AppleTalk services and covers the
following topics: 

m installing AppleTalk

m using SMIT to start, stop, and query AppleTalk 

m using AppleTalk in single port mode

m using AppleTalk in multiport mode, including the configuring of 
multihoming, routers, zones, and ports

m using AppleTalk Update–based Routing Protocol (AURP) to connect
AppleTalk networks

m using AppleTalk commands to check AppleTalk status, start and stop
AppleTalk, and test for network nodes

m configuring AppleTalk services such as the PPC daemon and Mac OS
utilities

m setting your default printer and creating print queues
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AppleTalk networking

AppleTalk is a set of simple and flexible network protocols that connect
computers and peripheral devices such as printers. AppleTalk over Ethernet
provides high-speed communications between computers. 

Apple Network Servers running AppleTalk can take advantage of the Mac OS
utilities such as the Disk Management Utility and CommandShell.

AppleTalk supports traffic on many ports concurrently. This allows you to use
multiple network interfaces (such as several Ethernet cards) at the same time. 

The AppleTalk kernel stack has full routing capabilities. This means you don’t
need a dedicated router to connect machines on multiple networks. If you do
not want to advertise AppleTalk routing services, use AppleTalk in 
multihoming mode.

AppleTalk can run on some or all of your network ports and can run in
parallel with other protocols on the port. For example, you can use AppleTalk
with TCP/IP. You can set up the protocols so they can share your network card
and cable, or you can dedicate separate ports for each protocol. 

To use AppleTalk, you need to configure your system. You use the System
Management Interface Tool (SMIT) to configure AppleTalk. If you have not
used SMIT, simply follow the steps in this chapter. You can learn more about
SMIT in Chapter 6 of this book.

Before you can use AppleTalk

To take advantage of AppleTalk services, you need to install the AppleTalk
software. This software is installed by default with the standard installation
process described in Chapter 2. If you need to reinstall AppleTalk, use the
Install Assistant. 

If AppleTalk is installed, entries for AppleTalk services will appear in the
SMIT menu for Communications, Applications, and Services.
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Setting up and managing AppleTalk

You can set up AppleTalk networking services through the System
Management Interface Tool (SMIT). 

To set up AppleTalk with SMIT:

1 Start SMIT.

To start SMIT, type smit at the command prompt. The main SMIT 
menu appears.
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2 From the main SMIT menu, choose Communications Applications and Services.

A new menu appears that lists the services.

3 Click AppleTalk.

SMIT displays the AppleTalk menu. 

The following sections describe each item.
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Using AppleTalk in single port mode

If you use AppleTalk in single port mode, you cannot use AppleTalk with
another network interface. 

To use AppleTalk in single port mode, choose the “Start AppleTalk in Single
Port Mode” item from the SMIT AppleTalk menu. The SMIT dialog box
presents three options.

In this dialog box, select the interface for AppleTalk. By default, the system
selects the built-in Ethernet interface (et0). Click the List button to view all
available interfaces.

If you want the system to prompt you to choose the default zone when
AppleTalk starts, enter yes in the zone selection field. When AppleTalk
starts and if several zones are available on the network, you must choose 
one of the zones as your home zone. If you select yes, the first available
zone is selected.
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In the Start AppleTalk dialog box, you can select when you want to start
AppleTalk services:

m now

m during the next system restart

m both—now and during the next system restart

By default, the services start immediately.

If you choose to start AppleTalk during the next system restart, or right 
away and during the next system restart, a configuration file
(/etc/rc.net.appletalk) is created and run during startup. 

Once you start the AppleTalk services, the system displays a message showing
the current configuration for your machine.

You can also get status information through the Show AppleTalk Status menu
in SMIT, or by using the atconfig command with the -q option.

Stopping AppleTalk 

To shut down AppleTalk, choose the Stop AppleTalk item from the SMIT
AppleTalk menu. When you choose the Stop AppleTalk item, the following
dialog box appears. 

You can stop AppleTalk only if there aren’t any processes using AppleTalk
services. If you try to stop AppleTalk while one or several processes are using
AppleTalk (such as a file server), the system displays a list of the processes 
using AppleTalk, and AppleTalk is not stopped.

You need to manually terminate each process using AppleTalk by stopping
the application or daemon. (You cannot stop AppleTalk services from SMIT.)
When you have terminated the processes that are using AppleTalk, you can
shut down AppleTalk.
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In this SMIT dialog box, you can then select when you want to stop 
AppleTalk:

m now (by default)

m during the next system restart

m both—right away and during the next system restart

If you choose to stop AppleTalk the next time the server starts, the 
file used to start AppleTalk automatically during startup is deleted
(/etc/rc.net.appletalk). The third option shuts down AppleTalk 
right away (if there aren’t any processes using AppleTalk services) and 
erases any startup settings for AppleTalk so that AppleTalk does not
automatically start during the next system restart.

Querying AppleTalk status

To view the current status of AppleTalk, choose the Show AppleTalk Status
item from the SMIT AppleTalk menu. This menu item queries AppleTalk and
returns the current status. 

For single port mode, the query returns information such as the AppleTalk
version, the AppleTalk interface, the network number, the node ID, and the
current zone. The following screen shows the status of a single port
configuration.
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For multiport mode, SMIT displays a line of information for each interface
currently configured. The line of information contains the name of the
interface, the state of the interface (most likely “Online”), and network
information including the network range, the AppleTalk address for the
interface (made of the network and node numbers), and the logical AppleTalk
port number. 

An asterisk (*) in front of a line means that this port is the home port (for
router mode only).

The following is an example of the result of a query about a four-port
configuration. Note that interface et2 is the home port.

-------- AppleTalk Configuration-----------

Network:

I/F   State           Range       Node    Default Zone

---- ---------------  ----------- ---------- ----

et1  Online           35281-35281 35281:88

*et2  Online           35282-35282 35282:149    Zone1

et3  Online           35283-35283 35283:210

et4  Online           35284-35285 35284:15

The following processes are using AppleTalk Services:

1864

10586

1349

When application programs or services are currently registered on the
AppleTalk stack, a list of the UNIX Process Identifiers (PID) of those
services is displayed. 
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Using AppleTalk advanced features

You can configure AppleTalk to take advantage of multiple network interfaces
by setting it up to run in multiport mode. Within multiport mode you must
choose either router or multihoming mode. Router mode allows connectivity
between networks and advertises AppleTalk routing services. Multihoming
does not route for the network and does not advertise on the network.

Administering an AppleTalk router

To use AppleTalk in router mode, you must understand the information and
configure AppleTalk as described in this section.

Providing seed information

Each AppleTalk network needs one router configured to provide seed
information. If your AppleTalk network does not have a seed router, you must
configure your Network Server to perform routing. If there is another seed
router on the network (you are connecting to an existing AppleTalk network),
you don’t have to set up a seed router. The port can use the seed information
from the existing router.

An interface is seeding when it allocates a range of network numbers for 
one or more zones on a network. A seed router sends an AppleTalk network’s
identifying information to other routers connected to that network. Other
routers obtain network information, such as zone names, from the seed
router. 

You use AppleTalk network and zone information to seed the network
interface. For each port that is not connected to a router, you specify the
network and zone information. You cannot start AppleTalk services until this
information has been provided.

For more information about configuring AppleTalk networks, see “AppleTalk
Networking Guide” and the manual for the Apple Internet Router. 

Configuring AppleTalk for a router

To configure your Network Server as a router for AppleTalk, use SMIT. (To
get to multiport configuration in SMIT, use the path Communications and
Services/AppleTalk.) 
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1 Click AppleTalk Advanced Features.

2 Click “Configure AppleTalk for Routing Mode.”

3 Click “Add or Change AppleTalk Network Interface.”

The Single Select List dialog box appears.
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4 Click the interface you want to use.

The “Add or Change AppleTalk Network Interface” dialog box appears.

To configure AppleTalk for router mode, provide the following information:

m AppleTalk Network Interface

SMIT automatically provides this information in the dialog box for the
interface you are configuring.

m Seed Port Network Range Start

If you are configuring your Network Server to be a seed port, provide the
first number in your network range. If you do not want to set up your
server as a seed port (if there is another seed router on your network),
leave this field blank or specify 0. If you specify a range and another seed
router exists on your network, your information must match.

If your Network Server is the only router on the network, you can use any
set of numbers for your network range from 1 to 65,279. 

Each number in your network range supports up to 253 devices for
networks with more than one segment and 254 devices for one-segment
networks. (See Inside AppleTalk for more information.) You need to have
enough numbers in your range to support the devices on your network.
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m Seed Port Network Range End

If you are configuring your Network Server to be a seed port, provide the
last number in your network range. If you do not want to set up your server
as a seed port (if there is another seed router on your network), leave this
field blank or specify 0. 

If your Network Server is the only router on the network, you can use any
set of numbers for your network range from 1 to 65,279. If another seed
router exists on your network, your information must match.

m Home Port

You must select a home port, even if it is not the seed port. The home port
is the physical networking interface and the default AppleTalk zone where
the AppleTalk services are registered and are advertised.

From a client perspective, the server home port appears as the zone where
AppleTalk services such as file sharing are found in the Chooser.

Note:  The home port only applies to multiport mode. In single port mode,
the home port is always the port chosen for AppleTalk services.

m Home Zone Number

Specify the number of the zone (from the list created in the next item) for
the home port. You must specify this zone only if the home port is a seed
port for a seed router.

m Zones

Creating a zone in an AppleTalk internet is a means of conceptually
grouping devices, which makes it easier for users to locate and access
network services. AppleTalk zones are created by routers and have no
physical boundary (so a zone can be used by several interfaces).

You must define at least one AppleTalk zone for the network on each port
configured as a seed port. The zone name can be shared between several
network interfaces. The name of the zone cannot be longer than 32
characters. You can use all characters, except the colon (:), at sign (@),
asterisk (*), and equal sign (=), in the zone name. Spaces are permissible. If
you use a tilde (~) character, precede the tilde with a backslash (\). If you
don’t, it is converted to a single quote. 

Use the List button to the right of this field to display existing zones for
other interfaces.
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Configuring AppleTalk for Multihoming

You configure network interfaces for multihoming through SMIT. You must
select a default zone for each network interface when you start AppleTalk,
and each default zone must be unique among the other network interfaces
included in the multihoming.

1 In SMIT, click “Communications and Services/AppleTalk.”

2 Click AppleTalk Advanced Features.

3 Click “Configure AppleTalk for Multihoming Mode.”

The Multihoming dialog box appears.

4 Click Add Interfaces.

The Multi-select dialog box appears.

5 Select the network interfaces to use and click OK. 

The Command Output dialog box appears and displays the command.

6 Click Done.

AppleTalk for multihoming is configured.

7 In the AppleTalk Advanced Features menu of SMIT, click “Start AppleTalk in 
multiport mode.”

AppleTalk configuration file 

When you configure AppleTalk, SMIT creates a configuration file. Normally,
you should not have to edit this file and you can perform all of your
configuration through SMIT. However, there are some situations when you
may need to edit this file. For example, if you want to have more than 15
zones, you need to add them directly to the configuration file because the
SMIT dialog box only displays the first 15 zones. (Note:  If you create more
than 15 zones in the configuration file, you cannot use SMIT to configure
AppleTalk.)
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Use a standard UNIX text editor such as vi to edit the configuration file.
Here is an example file:

#AppleTalk Configuration file

et1:35200:35350:*

:TestNet 1:et1:*

The pound sign (#) in the first line of the file indicates a comment that the
system ignores. The second line defines the network interface, specifies a
range of network addresses, and the asterisk (*) indicates that this is the home
port. The third line specifies a zone for the interface, and the asterisk (*)
indicates that it is the home zone. The following sections contain more
information about creating the lines for the configuration file.

A configuration file is in /etc/appletalk.cfg. This file contains further
explanation and examples.

If you use multi-homing, SMIT creates the file /etc/appletalkmh.cfg.
This file contains a list of interfaces (such as et0, et1, and so on).

To specify your home port in the configuration file, you add an asterisk (*) to
the end of the line.

For example, the line

et1:*

specifies that the interface will be used as the home port.

After you specify the interface in the configuration file, you can specify a
network range. The following line in an AppleTalk configuration file seeds
the et0 interface (Ethernet card 0) with addresses ranging from 25 to 50:

et0:25:50

118 Chapter 7 / Setting Up AppleTalk and AppleTalk Services



For a nonseed entry, the configuration simply consists of the name of the
interface followed by a colon. The optional asterisk (*) means that the
interface will be used as the home port for AppleTalk services. The following
lines in a configuration file show entries for nonseed entries: 

et0:

et1:*

There must be only one home zone, and the home port must be listed in 
this entry.

Entries for the zones and interfaces can be mixed throughout the 
configuration file.

The format for zone definition is

:name:interface:optional asterisk

Here is an example zone for an AppleTalk configuration file:

:TestNet 1:et1:*

In the configuration file, a zone name entry must begin with a colon (:). The
first field of the configuration line is the name of the zone (no longer than 32
characters). All characters, except the colon (:), at sign (@), asterisk (*), equal
sign (=), and tilde (~) can be part of the zone name. Spaces are permissible.

The next fields are separated from the zone name field by a colon (:) and
designate the list of (seed) interfaces using this zone name. If the zone name
is to be used as the home zone, use an asterisk (*) as the last character of the
zone configuration line. 
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Starting AppleTalk and setting multiport options 

When you choose the “Start AppleTalk in Multiport Mode” item from the
SMIT AppleTalk menu, you can specify the following options: 

m the interport routing mode

m the multiport mode to use

m when to start the AppleTalk multiport configuration

The following sections describe each option.

Setting the interport routing traffic option

With the interport routing mode option, you can specify the amount of traffic
allowed through the router (the traffic not going to the services published on
the home stack, such as a file server). 

This option allows the network administrator to choose how the AppleTalk
kernel stack behaves—as a router or as an entity dedicated to the services on
the server, “discouraging” users from performing cross-traffic file transfers. 
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With this option, you specify the maximum number of packets per second
allowed to cross from one network to another. Once the system reaches the
maximum number of packets per second, the system begins to drop packets.
If you choose the default value, AppleTalk determines a reasonable number
of packets to route from one port to another. Because routing uses the
processing power of your Network Server, you may want to lower the default
value. (The minimum value for this field is 500 packets per second.)

Note:  This option does not limit the number of packets going to the home
stack.

As an example, here are some possible values and their effects. (These
numbers are simply guidelines and different network configurations may have
slightly different ranges.)

m A value of 750 makes interport transfers slow for users but does not use
much of the processing power of your Network Server.

m A value of 2500 allows several users to perform transfers from one port to
another, but you may notice degraded performance for other applications
on your Network Server. 

m A value of 5000 ensures that most of the systems resources are available
for interport routing. With this value, routing could take up most of the
system resources and significantly degrade the performance of other
applications. 

Note:  There is no upper limit for the interport routing value, but a value
above 5000 ensures that most of your system resources are available for
routing.

Specifying a multiport mode

This field displays the multiport mode for the Network Server. You can
choose either router or multihomed mode.
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Specifying when to activate AppleTalk

You can also specify in this SMIT dialog box when the AppleTalk multiport
configuration takes effect. You can choose

m now

m during the next system restart and consequent system starts

m both—right away and for all future system restarts

Note:  If you have changes that take effect during a system restart, the system
creates a file (rc.net.appletalk) and overwrites any previous AppleTalk
configuration that may have been selected. 

Removing an AppleTalk network interface

You can remove an interface from your system if you are no longer using it.
When you delete an interface, you also delete the zones that are specific to 
the interface.

To remove a network interface from your AppleTalk configuration: 

1 Depending on your multiport mode, choose either “Configure AppleTalk for Routing
Mode” or “Configure AppleTalk for Multihoming Mode” from the SMIT AppleTalk
Advanced Features menu.

2 Click “Remove Network interface.”

A dialog box appears that lists configured interfaces.

3 Specify the interface to remove.

You can use the List button to display the available interfaces.

4 Click OK.
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Using AURP 

AppleTalk for the Network Server includes AURP (AppleTalk Update–based
Routing Protocol). AURP is also known as IP tunneling.

You can use this protocol to connect AppleTalk networks that are separated by
a non-AppleTalk network (such as TCP/IP). 

To configure AURP:

1 In SMIT, select Communications/AppleTalk/Advanced Features.

2 Click Configure AURP (IP Tunneling).

3 Click Configure Local IP Address and specify an address.

You can specify the address of the Network Server.

4 Click Add Remote IP Address and specify remote IP addresses. 

You can specify as many remote IP addresses as you want. You can exchange
AppleTalk information with each remote address you specify. You can specify
IP addresses in either dot or hostname format.
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5 To make part of the network unavailable to the remote hosts, select Add Hidden
AppleTalk Networks and specify the address of the network to hide.

6 To specify the part of the network that remote hosts can view, select Add Exported
AppleTalk Network. 

Note:  You can only use either Add Hidden or Add Exported. When you
choose Add Exported, it erases any information specified by Add Hidden.
Similarly, if you specify Add Hidden, you erase any information specified by
Add Exported. You can use the “Remove Hidden or Exported AppleTalk
Network” option to erase all information about hidden and exported
networks.

This protocol only transmits routing information when the information
changes, rather than periodically broadcasting the information over the
network.

You can view your AURP configuration with the Show AURP Configuration
menu item.

Using AppleTalk commands

AppleTalk provides many commands to help you gain information about
AppleTalk services. This section describes the most common uses of three
commands. The commands are fully described in the manual pages. 

The AppleTalk commands are located in the /usr/sbin directory.

The atconfig command performs most AppleTalk operations. Consult the
online help to see a complete list of command options.
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Querying and stopping AppleTalk with the atconfig command

You can use the atconfig command with the -q option to determine 
the current status of AppleTalk. If the AppleTalk kernel stack is active, the
command

atconfig -q

returns information including the current node ID, network number, bridge
address, and related information.

If no AppleTalk services are running but the AppleTalk kernel stack is still
configured, you can shut down the AppleTalk kernel stack by running the
following command:

atconfig -u

This command requires root access and should be used with caution. If any
AppleTalk services are still in use, the command returns a list of the process
identifiers of the UNIX processes currently using AppleTalk. You can’t stop
AppleTalk until you stop those processes.

When the shutdown is complete, you may run atconfig -q to ensure that
AppleTalk is no longer running. 

Using atlookup to list the NVEs in a zone

The atlookup command returns a list of all NVEs (network visible
entities) in a given zone. The syntax for this command is

atlookup <object>:<type>@<zone>

where type is, for example, a printer or server type, object is typically the host
name or other object name, and zone is the AppleTalk network zone. An equal
sign (=) is treated as a wild card in the <object> and <type> fields, and an
asterisk (*) represents the current zone.

For example, atlookup "=:LaserWriter@*" would return all
LaserWriters registered in the current zone. 
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Using appleping to ensure that a node is active

You can use the appleping command to ensure that a given node is active.
The appleping command uses the AppleTalk Echo Protocol. The format
for this command is

appleping <name>:<type>[@<zone>][packet-size[npackets]]

The name:type@zone parameter specifies the host computer by its name,
type, and zone. If you do not specify a value for zone, appleping uses the
local zone. The npackets parameter specifies how many packets to send before
terminating, and packet-size specifies the size of each packet in bytes. The
value of packet-size must be between 14 and 599; by default, its value is 
64 bytes.

The appleping command reports whether a reply was received. The
appleping command continues to send packets and to display the result
until the number of packets specified or until you issue the interrupt character
(usually by pressing Control-C). Before exiting, appleping displays a
summary of statistics.

Configuring AppleTalk services

The AppleTalk Services item in the SMIT Communication and Services menu
lets you configure the Program-to-Program Communication (PPC) daemon
and lets you set up AppleTalk printing. 

Setting up and starting the PPC daemon

The PPC daemon supports applications such as the Disk Management Utility
and CommandShell and manages the exchange of AppleTalk communications
between Mac OS utilities and your Network Server. 
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You can use the Program-to-Program Communication option in the SMIT
AppleTalk Services menu to start, stop, and customize the PPC daemon. You
can also use this option to add to the server new daemons that you have
created for Mac OS utilities.

To use Mac OS utilities, you must start the PPC daemon. To start the 
PPC daemon:

1 Click “Start the ‘ppcd’ daemon.”

This option appears in the Program-to-Program Communication menu
available from the AppleTalk Services menu.

A dialog box appears. 

2 Specify when you want to start the daemon.

You can start the daemon now, at the next system restart, or both.

3 Provide a hostname for your computer.

4 Click OK.

The daemon starts.

In addition to starting the PPC daemon, the PPC daemon selection under the
AppleTalk Services item contains the following options: 

m Stop the ‘ppcd’ Daemon 

m List all ‘ppcd’ Services 

This option displays all the daemons on the server used for Mac OS
utilities such as the Disk Management Utility, the Status Demo AppleTalk
Services application, and CommandShell. If you have added any additional
daemons, they will also be displayed.
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m Add a ‘ppcd’ Service

This option lets you add a new daemon for a Macintosh utility to your
system. When you choose this option, a dialog box appears that lets you
specify information for the daemon. 

To add a PPC daemon service, you need to specify:
—Name of the service. Specify the name of the PPC component as you

want it to appear in the PPCBrowser dialog box for the Mac OS client.
Do not use spaces in the name.

—User ID. Provide a user name or user ID. This value determines the
privileges the application has when it runs.

—Group ID. Provide a group name or group ID. This value determines the
privileges the application has when it runs.

—Path of the daemon executable. Provide the full path to the server
component (daemon).

—Daemon signature. The signature is a unique four-letter code that
identifies the daemon. Mac OS clients use the signature to filter Mac OS
utilities and search for specific types of applications.
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—Guest access. The guest field is optional. If you select guest access, any
client can connect to the application as the guest user (an actual
account). If you choose not to have guest access, the user must supply a
valid account (user name) and password to start the Mac OS utility. 

—Privileged users. If you want specific users to be able to run an
application with extra privileges (such as root privileges), provide their
names in this field. If a user is listed in this field, the user ID and group
ID values are not used.

m Change/Show Characteristics of a ‘ppcd’ Service

After you select this option, select a service (daemon) to examine. The
same options appear as those for the “Add a ‘ppcd’ Service” option. You
can change any of them or just examine them.

m Remove a ‘ppcd’ Daemon

Deletes an entry for a daemon from the PPC daemon configuration file. 

Setting up AppleTalk printing capabilities

To use AppleTalk for printing, you need to set a default printer and set up a
print queue to allow print spooling. To do so, choose the AppleTalk Services
item from the Communication and Services menu and choose the Configure
AppleTalk Printing item. This item lets you select an AppleTalk printer and
view printer status.

You can use the “Select an AppleTalk Printer” item to specify your printer.
Before you can specify a printer, you need to start AppleTalk in either single
port or multiport mode.
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To select an AppleTalk printer:

1 Choose Change or “Select an AppleTalk Printer” in the AppleTalk Services section 
of SMIT.

A dialog box appears.

2 Specify your AppleTalk zone.

You can use the List button to see the available zones.

3 Click OK.

A list of available printers in that zone appears.

4 Select the printer you want.

Your printer is now selected as your default AppleTalk printer.

When you select an AppleTalk printer, the system creates a print queue 
named DEF_ATALK_PR_Q. If a print queue did not previously exist, the
DEF_ATALK_PR_Q is set to your systemwide default print queue. You 
can also set the systemwide default queue through SMIT with the Print
Spooling option.

Once you have selected an AppleTalk printer, you can print using UNIX
commands such as lpr, enscript, and pr. If you do not specify a print
queue with UNIX commands, the print job is sent to the default print queue.
You can use command-line options to specify your print queue. For example,
the lpr, enscript, and pr commands can be used with the -P queue
option, which lets you specify the print queue.

If you want to configure several printers and print queues, refer to the 
onscreen documentation in InfoExplorer for printers and printing. 

Note:  If you use a tilde (~) character in the name for the default printer, 
it is converted to a single quote. To avoid this, precede the tilde with a
backslash (\).
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Managing logical volumes in AIX is complex. To simplify this process, Apple
Computer provides the Disk Management Utility. The Disk Management
Utility graphically represents the relationships between physical volumes,
volume groups, logical volumes, and file systems and lets you make changes
by dragging icons and using dialog boxes. 

This chapter describes how to set up and use the Disk Management Utility
application to perform logical volume management. 

The topics covered in this chapter include

m understanding logical volume management

m understanding the Disk Management Utility

m setting up the Disk Management Utility

m starting the Disk Management Utility

m using the overview window

m configuring physical volumes, logical volumes, and file systems

m exiting the Disk Management Utility

8 Managing File Storage With 
the Disk Management Utility



Overview of logical volume storage

Logical volume storage provides a transparent method of dividing and
allocating storage space on the system’s disks. The set of operating system
commands, library subroutines, and other tools that allow you to establish and
control logical volume storage is called the Logical Volume Manager (LVM).
The Disk Management Utility lets you utilize the LVM through the
Macintosh interface on remote Mac OS clients. 

Using the LVM, you can combine several physical disks (physical volumes)
into a single volume group, which acts like a single large disk. The volume
group can then be partitioned into individual logical volumes. Individual
logical volumes can be allocated across multiple physical disks.

At the base of the logical volume storage system lies the hard disk drive, or
disk. To be used by the operating system, the storage space on a disk must go
through a process of configuration. This section describes that process.

For more information about logical volume management, see “Logical
Volumes” in the System Management Guide: Operating System and Devices
available through InfoExplorer.

Physical volumes

First, the disk must become a physical volume. A physical volume is a disk
connected to the computer system with certain configuration and
identification information. A disk must be designated a physical volume 
and put into an available state before it can be assigned a volume group. 

The first time you start up the system after connecting a new disk, the
operating system detects the disk and examines it to see if it has a unique
physical volume identifier (PVID) in its boot record. If it does, the drive is
designated as a physical volume with a physical volume name (typically
hdiskx where x is a systemwide unique number). The unique physical
volume identifier for a physical volume remains with the associated disk even
if the disk is moved to another physical location on the system.
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Volume groups

The disk as physical volume must now become part of a volume group. A
volume group is a collection of 1 to 32 physical volumes, possibly of various
size and type. When you install AIX, you automatically create the root
volume group (rootvg). 

You create additional volume groups with the New Volume Group command
in the Configuration menu in the Disk Management Utility. Other commands
from the Configuration menu let you configure and remove volume groups.

Small systems may require only one volume group to contain all the physical
volumes attached to the system. On larger systems, the use of multiple volume
groups adds storage flexibility. You can create volume groups to separate
groups of disks for security, maintenance, or performance reasons.

You can migrate data from one physical volume to another physical volume in
the same volume group. This allows you to free the physical volume so it can
be removed from the volume group. 

Disks that are not considered physical volumes (disks without physical volume
identifiers) cannot be added to volume groups. Some examples of devices that
cannot be physical volumes include floppy disks, CD-ROM discs, and all
types of network-attached devices.

Logical volumes

After you create a volume group, you can create logical volumes within that
volume group. A logical volume is a collection of logical partitions that are
grouped as a single storage entity. Logical volumes can be used for storage or
as the base for a file system. (Logical partitions and file systems are discussed
in the following sections.) 
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When you install the operating system, you automatically create one volume
group (the root volume group) consisting of a base set of logical volumes
required to start the system plus any other volume groups you specify. The
root volume group contains such things as paging space, the journal log, boot
data, and root file system, each in its own separate logical volume.

The maximum number of user-defined logical volumes per volume group is
255, but the actual limit is determined by the total size of the combined
physical volumes assigned to the volume group.

Logical volumes can also be copied, removed, and have the number of copies
they maintain increased or decreased (mirrored copies). They can also be
relocated through a reorganization of their volume groups. However, there are
some restrictions concerning the use of copied logical volumes. For example,
a primary dump device cannot be a copied logical volume. Any dumps
attempted to a copied logical volume will fail, and no error message will be
displayed. 

When you create a logical volume, you can choose to create a striped logical
volume. A striped logical volume evenly allocates data on each disk that you
specify. For example, if you had three hard disks to use for a striped file
system, each hard disk would have the same number of blocks of data. When
you create a striped logical volume, you need to ensure that the size of the
logical volume is evenly divisible by the partition size to ensure that the data
can be stored equally. You need more than one hard disk to create a striped
file system. 

Logical partitions

When you create a logical volume, you specify the number of logical
partitions for the logical volume. A logical partition is one, two, or three
physical partitions, depending on the number of copies you specify for the
logical volume. Specifying one copy means there is only the original copy of
the logical volume. Therefore, if you specify only one copy of the logical
volume, there is a direct mapping of logical partitions to physical partitions. 
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Mirroring

The ability to specify more than one copy of the logical volume data through
logical partitions is called mirroring. Mirroring decreases data access time by
allowing the LVM to choose which copy (physical partition) of the data can
be accessed first. Mirroring increases data availability and helps you recover
data after a system error. 

File systems

The final step in the evolution of a disk is the creation of file systems. You
can create one file system per logical volume. 

The advantages of logical storage

As described in the previous sections, the LVM controls disk resources by
mapping data between logical and physical storage. This section explains
some aspects of logical volume storage that may not be readily apparent from
the previous discussion. 

To put it simply, physical storage specifies where the data resides on the disk
itself. Logical storage controls what data is presented to the user. Data in a file
system appears to be contiguous to the user, but can be located on disk
partitions that are not side by side (contiguous) on the disk and might not be
on the same disk. Logical storage makes it easy to expand the file system as
needed and to make copies of it on other disks to protect against disk failure.
These features provide you with increased availability of data and flexible
management of the disk subsystem.

Logical storage is mapped to physical storage when the LVM references data
represented in the logical partition. The data is stored in either one, two, or
three physical partitions. A logical volume can span physical volumes because
it is composed of logical partitions allocated onto physical partitions within
the volume group.
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Any available physical volume attached to the system can be grouped into a
volume group. The user sees each volume group as a set of one or more 
logical volumes. The operating system uses separate logical volumes for
specific purposes, such as page space, file systems, journal log, boot data, or
dump storage.

Because a logical volume is just a collection of one or more physical
partitions within a volume group, the location, number of copies, and size of
the logical volume can be easily changed after the logical volume is created.

Through mirroring, you can keep copies of the user data and file system
superblock data on different physical volumes (optionally on a different
adapter), providing up-to-the-last-second protection against hardware failure.

Note:  While mirroring improves storage system availability, it is not intended
as a substitute for conventional tape backup arrangements.

Overview of the Disk Management Utility

The Disk Management Utility provides access to storage management on
systems running the AIX operating system. Users manage disk storage
through menus and by clicking and dragging icons that correspond to storage
objects on an AIX server. The Disk Management Utility lets you 

m configure, group, ungroup, and format physical volumes

m create, rename, and remove volume groups

m create, rename, and remove logical volumes and file systems

The Disk Management Utility consists of a Mac OS application and an 
AIX daemon process. The two components communicate by exchanging
Apple events. 

You start the Disk Management Utility by starting the Disk Management
Utility Macintosh component from the Finder of a remote Mac OS client. 
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Setting up the Disk Management Utility

Follow these steps to set up the Disk Management Utility. 

1 Install and activate AppleTalk on the server.

For information about setting up AppleTalk, see Chapter 7, “Setting Up
AppleTalk and AppleTalk Services.”

2 Start the PPC daemon on the server. 

For information about starting the PPC daemon, see Chapter 7, “Setting Up
AppleTalk and AppleTalk Services.”

3 Run the AppleTalk services program on the remote Mac OS client and ensure you install
the Disk Management Utility and Network Server Passwd Tool. 

Use the Mac OS Utilities for the Network Server With AIX disk provided with
AIX to install the Disk Management Utility. For complete installation
instructions, see “Installing Mac OS Utilities on a Mac OS Client” in 
Chapter 2, “Installing AIX on Your Network Server.” 

4 Ensure that you have an account on the server.

You can log on as Guest if you do not have an account, but you cannot make
changes to the file system structure.

Once you have satisfied these requirements, you are ready to use the Disk
Management Utility.
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Starting the Disk Management Utility

To start the Disk Management Utility:

1 On the remote Mac OS client, double-click the Disk Management Utility icon.

The “Select a UNIX server” dialog box appears.

2 Select connection options.

In the AppleTalk Zones box, click the zone of the server you want. If you do
not have zones configured for your network, the dialog box does not have an
AppleTalk Zones box and you do not need to specify a zone.

In the Macintoshes box, click the name of the server that you want to 
connect to.

In the Servers box, click Disk Management Utility.
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3 Click OK.

A user authorization dialog box appears.

4 Type your user name and password.

To manipulate file systems, you must log in as the root user or be specified as
a privileged user in the PPCD configuration file (see Chapter 7, “Setting Up
AppleTalk and AppleTalk Services” for more information). 

If you do not log in as root or a privileged user, you can only view the
structure of your file system management.

You can select the Guest button to log in to the server with read-only access.
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5 Click OK.

The Disk Management Utility overview window appears and displays your
physical volumes, volume groups, and file systems.

Using the overview window

When you start the Disk Management Utility, you see an overview window
that displays an overview of physical volumes, volume groups, and file
systems for your system. 

Unassigned physical volumes in this overview window may be manipulated
directly by clicking and dragging them with the mouse. You can also use
menu commands to perform many tasks. By manipulating objects in this
window, you can change the relationships of physical volumes, volume
groups, and file systems. For example, you can add an unassigned physical
volume to a volume group. You select a physical volume icon and, while
holding the mouse button down, drag it to any of the volume group or file
system icons. Dragging a physical volume onto a volume group icon adds that
physical volume to the volume group. 
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In the overview window, you can choose to view specific types of
components. You can click the buttons in the upper-right corner of the
window to change the contents of the overview window to view physical
volumes, volume groups, and logical volumes. 

Note:  You can only drag physical volume icons in the overview window.
When viewing only physical volumes, volume groups, and logical volumes,
you must use menu commands to perform actions.

Working with physical volumes

You can view physical volumes in the overview window, or you can click the
physical volume view icon and see a list of physical volumes, as in the
following example. 

In this view, you can double-click a physical volume icon to display a
configuration dialog box, but you cannot drag icons as you can in the 
overview window.
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Configuring physical volumes

To configure a physical volume:

m Double-click the physical volume icon in the overview window.

A Physical Volume dialog box appears.

You can also open this dialog box by selecting a physical volume icon in the
overview window and choosing Configure from the Configuration menu. 

Use this dialog box to make the physical volume available or unavailable for
use by the system, allow or disallow allocation of partitions from this physical
volume, and perform a low-level format of the physical volume.

Note:  Only unassigned physical volumes can be formatted. If you select an
assigned physical volume, the Format button is unavailable.

You can use the Migrate button in this dialog box to transfer data to other
disks in the same volume group. You need to migrate data to clear a disk
before you can remove it from a volume group.

By default, physical volumes are available for use, and allocation of partitions
is allowed. You rarely need to change these defaults. However, there are
occasions when you may need to. For example, when removing a physical
volume from a volume group that is in use by the system, you first need to
disallow allocation of partitions from that physical volume. Next, you would
migrate all data from the physical volume and then you would remove the
physical volume from the volume group.
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On a rare occasion, you might need to perform a low-level format on an
unassigned physical volume. This could be required because you want to
“wipe clean” all data from the disk, or perhaps because the disk has
developed questionable data blocks and you want to use the format process 
to find the bad blocks and remap them. If you choose the Format button, the
following alert box appears.

This alert box indicates the name of the physical volume as well as the 
SCSI device and bus identification numbers. Click Format to confirm this
operation. If you click Cancel, you return to the original window without
making any changes. 

Grouping physical volumes

In the overview window, you can drag a physical volume icon onto a volume
group icon to add it to the group, and you can drag a physical volume onto a
file system icon to add the physical volume to the volume group of the file
system. If you drag a physical volume to the volume group, the additional
space it brings to the volume group is allocated as free space on the volume
group. If you drag a physical volume to a file system, the additional space it
brings is allocated to the file system, increasing its size by that amount. 
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Working with volume groups

You can view volume groups in the overview window, or you can click 
the volume group view icon and see a list of volume groups, as in the
following example. 

In this view, you can double-click a volume group icon to display a
configuration dialog box, but you cannot drag icons as you can in the
overview window. Each volume group icon is preceded by a triangle. If you
click the right-pointing triangle, it rotates downward, and the physical and
logical volume elements associated with the volume group are displayed. 

Creating new volume groups 

Use the New Volume Group command in the Configuration menu to create
new volume groups. To use this command, you must be connected to a
Network Server and have unassigned physical volumes. When you use this
command, a dialog box similar to this one appears. 
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For each volume group you create, you must provide a name. You can also
specify the size of the physical partitions, when to make the volume group
active, and the disks to use.

Configuring a volume group

To configure a volume group: 

m Double-click the volume group icon in the overview window.

A Volume Group dialog box appears.

You can also open this dialog box by selecting a volume group icon in the
overview window and choosing Configure from the Configuration menu. 
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Use this dialog box to set the volume group for activation each time the
system starts, activate the volume group, deactivate the volume group, and
reorganize the volume group.

When you activate a volume group, you make it usable by the operating
system, and when you deactivate a volume group, you make that volume
group unusable by the operating system.

Volume group reorganization relocates logical volumes and their data on 
the volume group. This is done by changing the desired location on the
volume group that a logical volume occupies.

You usually change the position of a logical volume before reorganizing the
volume group. This type of change is done in the dialog boxes that
correspond to logical volumes and file systems (see the next section,
“Working With File Systems and Logical Volumes”). 

For reorganization, you select one of three location values: center, middle,
and edge. These locations specify where the logical volume will reside on the
hard disk—near the center, midway between the center and the edge, or near
the edge of the disk. Volumes near the center of the disk can be accessed
faster. Large and heavily used file systems, such as /, /usr, and /home, are
candidates for center. Small and seldom-used logical volumes that contain file
systems like boot and sysdump are good candidates for edge. Set logical
volumes with file systems of moderate size and activity to middle.

Additionally, a flag for each logical volume indicates if the logical volume can
be relocated. This flag must be set in order for volume group reorganization
to have any effect on that logical volume. 
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When you click Reorganize, an alert box appears.

Click Cancel to stop the reorganization process without changing the volume
group or any of its logical volumes. Click OK to start the reorganization
process. The reorganization process can take a long time and cannot be
stopped once it begins.

Working with file systems and logical volumes

You can view file systems and logical volumes in the overview window, or
you can click the view icon for file systems and logical volumes and see a list
of file systems and logical volumes, as in the following example. 
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In this view, you can double-click icons for file systems and logical volumes
to display a configuration dialog box, but you cannot drag icons as you can in
the overview window. 

In the Disk Management Utility overview window, logical volumes have the
following types of icons and information.

Logical volume Size Meaning

4MB The logical volume is without an associated file system. The 
size of the logical volume appears after the icon. On systems 
with a color display, the top of this icon is gray.

8MB The logical volume has a mounted file system. The size of 
the file system appears after this icon. On systems with a 
color display, the top of this icon is green.

- The logical volume is associated with a file system that is not 
mounted. On systems with a color display, the top of this 
icon is orange.

Creating new file systems 

Use the New File System command in the Configuration menu to create new
file systems. To use this command, you must be connected to a Network
Server and you must select a volume group for the file system. When you use
this command, Disk Management Utility displays a New File System dialog
box. 

For each file system you create, you must specify a volume group, a mount
point, a size, and a type. The type can be any of the following:

m JFS.  Journaled File System, the standard file system for AIX.

m Raw.  Use this type of logical volume for application-specific file systems
such as databases.

m Paging.  This type of logical volume frees memory by rotating tasks 
in memory.

m Boot.  This is a special type of logical volume used for starting the 
Network Server.

m Sysdump.  This type of logical volume is used to store data during a 
system failure.
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m JFSlog.  Each volume group has one JFSlog file system. This logical volume
tracks system actions, and is created automatically when you create the
first JFS file system on a volume group.

You may also specify settings for the JFS file system such as fragment size
and bytes per inode. The fragment size is the smallest unit of disk space that
can be allocated to a file. If your file system won’t change often, use a smaller
fragment size for more efficient storage. If you have an active file system, use
a larger number so a file can be stored all in one area of memory. You also
need to determine the bytes per inode. This number can limit the size of your
file system. If you choose a large number, you reduce the number of inodes
available. If you use all of your inodes, you may not be able to use all of your
disk space. 

You can also use the New File System dialog box to create a striped logical
volume or file system. A striped logical volume evenly allocates across
several hard disks. If you choose to create a striped file system, you need to
ensure that the size of the file system is evenly divisible by the number of
disks and the physical partition size so each disk can have the same amount of
data. For a striped file system, you also need to have more than one physical
volume in the volume group. 
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Configuring logical volumes and file systems 

To configure a logical volume:

m Double-click a logical volume icon in the overview window.

If the logical volume has a file system associated with it, a dialog box similar
to this one appears.

You can also open this dialog box by selecting a logical volume icon in the
overview window and choosing Configure from the Configuration menu. 

You can use this dialog box to

m examine information about the logical volume, such as size, amount of free
space, name of volume group, and size of logical partitions

m change the mount point of the file system

m increase the size of the file system (in multiples of the physical partition size)

m set the file system to be automatically mounted at system startup

m set read and write permissions for the file system

m set mirroring characteristics for the file system

m display a dialog box to configure attributes for logical volumes (by clicking
the Advanced Settings button)

When you have made your selections, click OK. 
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If you click the Advanced Settings button or if you double-click a logical
volume that does not have a file system associated with it, the following
dialog box appears.

This dialog box contains information about the logical volume and many
configuration options.

For the configuration section, you can choose from the pop-up menu either
General Attributes or Allocation Policy to change the related settings. The
dialog box displays the General Attributes settings.
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When you choose Allocation Policy, the dialog box looks like this.

You can then configure the attributes of the logical volume that pertain to the
allocation policies.

By default, logical volumes are not mirrored, so the operating system keeps
one copy of the logical volume on the disk. You can change this setting so that
the operating system keeps two or three copies of the logical volume on disk.
If copies span physical volumes, you can specify that copy updates be done in
parallel or sequentially. You can also specify that whenever multiple copies
are being kept, the operating system must perform write consistency checks
and keep each copy on a separate volume. You can also specify the physical
volumes that the logical volume should mirror.

General allocation attributes of the logical volume the user may alter include

m where the logical volume should reside on each physical volume 

m whether the operating system should perform allocations across the
minimum or maximum number of physical volumes possible

m the maximum number of physical volumes the operating system should use
when allocating space for the logical volume

When you have made your changes, click OK. 
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This chapter describes how to use CommandShell to interact with AIX.

The CommandShell application lets you log in to AIX from a Mac OS client
over an AppleTalk network. CommandShell provides a VT100-compatible
terminal emulation environment to run AIX commands. With
CommandShell, you can open more than one window to run commands.

This chapter describes how to set up and use the CommandShell application
to perform remote system administration using a command line and
traditional UNIX commands.

The topics covered in this chapter include

m overview of CommandShell

m setting up CommandShell

m using CommandShell windows

m customizing CommandShell windows

m using Mac OS editing tools in a CommandShell window

m exiting CommandShell
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Overview of CommandShell

CommandShell is an application provided by Apple Computer to let you
communicate with a Network Server running AIX from a remote Mac OS
client. From the Mac OS client, you can send commands to the AIX system to
perform such tasks as system administration and troubleshooting.

The CommandShell application consists of a Mac OS client component and 
an AIX server component. These components exchange information through
Apple events and let you run commands on the AIX server from a remote 
Mac OS system.

From CommandShell, you can run any standard AIX administration
command, such as smit or info -a.

Setting up CommandShell

To use CommandShell with AIX, you must complete the following steps. 

1 Install and activate AppleTalk on the server.

For information about setting up AppleTalk, see Chapter 7, “Setting Up
AppleTalk and AppleTalk Services.”

2 Start the PPC daemon on the server. 

3 Run the AppleTalk Services program on the remote Mac OS client, and ensure that you
install CommandShell, CommandShell VT102, and the Network Server Passwd Tool.

Use the Mac OS Utilities for the Network Server With AIX disk provided with
AIX to install CommandShell. For complete installation instructions, see
“Installing Mac OS Utilities on a Mac OS Client” in Chapter 2, “Installing
AIX on Your Network Server.”  

4 Ensure that you have an account on the server.

Once you have satisfied these requirements, you are ready to use the
CommandShell application.
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Starting CommandShell

To start a CommandShell session: 

1 On the remote Mac OS client, double-click the CommandShell icon.

The menu bar changes to display the CommandShell menu and the “Select a
CommandShell Server” dialog box appears.

2 Select connection options.

In the AppleTalk Zones box, click the zone of the server you want. If you do
not have zones configured for your network, the dialog box does not have an
AppleTalk Zones box and you do not need to specify a zone.

In the Macintoshes box, click the name of the server that you want to connect
to.

In the Services box, select the CommandShell application.
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3 Click OK.

A user authorization dialog box appears.

4 Type your user name and password.

5 Click OK.

A window for CommandShell appears.
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Using CommandShell windows

The following sections describe how to use the windows in CommandShell. 

Displaying CommandShell windows

When you create a CommandShell connection, a window appears. You can
display additional windows by

m choosing New Connection from the File menu

m pressing Command-N

The windows are numbered in the order in which they are created.

Arranging CommandShell windows

There are three ways to arrange CommandShell windows on the screen. Use
the Window menu to choose window options.

m Standard position. When you create a new window, it appears in front of
and slightly below the previously created window. 

m Tiled. You can tile the windows to arrange them alongside each other with
their edges touching. Tiling windows reduces the size of the windows so
they fit on the screen. You can tile windows horizontally and vertically.

m Resizing and dragging. You can arrange CommandShell windows by using
their resize boxes and by using their title bars to drag the windows to new
locations on the desktop.
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Recording the contents of a window

As new lines are added to a CommandShell window, the top lines may scroll
past the top edge of the window. CommandShell automatically records a
preset number of these lines. This allows you to view them by scrolling
upward. By default, CommandShell records 300 lines.  

CommandShell does not save any lines after you close a window. If you are
working with text that you don’t want to lose, save the information to a file. 

You can stop CommandShell from recording the top line of the active 
window by choosing the Don’t Record Lines Off Top command from the
Commands menu. 

If you want to erase lines that have been recorded, choose the Clear Lines Off
Top command from the Commands menu. This command operates on the
active window only.

Saving a CommandShell connection

You can save all of your current connections with the Save Connections
command from the File menu. This command saves all of your current
connections in a file. You can open this document to restore your connections. 

Closing a CommandShell window

There are three ways to close a window: 

m Choose Close from the File menu.

m Press Command-W.

m Click the close box of the window.

Note:  Before you can close a window, it must be the active window.

If you close a window in which a process or program is running, the process
stops. An alert box warns you of this and gives you the option of keeping the
window open.
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Customizing CommandShell windows

If you use CommandShell windows often, you may find it convenient to
establish an ideal arrangement of windows so they are always set up the way
that you want. 

Presetting window defaults

The Active Window Settings command in the Preferences menu lets you

m specify window position

m save an initial command to execute on login

m change the title of the window

m change the number of lines to record

m select terminal settings

Presetting the appearance of new windows

You can change the default settings that control the appearance of new
windows before you create them. 

m Choose New Window Settings from the Preferences menu.

The New Window Settings dialog box appears.
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You can decide to extend the active window settings to all new windows by
selecting Use Active Window Settings.

This dialog box also allows you to preset the window size, the screen font,
and the maximum number of lines to save.

Using Mac OS editing tools in CommandShell windows

You can use standard Mac OS editing tools such as copy and paste while
working in CommandShell windows. These commands allow you to paste a
series of commands or a long, complex command into another window
without having to retype it. When you press Return, AIX runs the pasted
command.

Exiting CommandShell

To exit CommandShell:

m Choose Quit from the File menu.
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This chapter describes how to solve problems that you may encounter when
using AIX. This chapter is not a complete troubleshooting reference. This
chapter provides information to help you when you cannot get to InfoExplorer
to examine the complete list of error messages, LCD display codes, and
problem-solving suggestions.

The topics covered in this chapter include

m starting your Network Server from maintenance mode and displaying a
prompt to examine your root volume group

m correcting an unresponsive system

m responding to error messages during installation, both three-digit error
codes on the LCD display and text messages on your screen

For information about solving problems related to your hardware, refer to
Setting Up Your Network Server.

The AIX Version 4.1 Messages Guide and Reference includes reference and
recovery information for seven-digit error messages and three-digit error
codes in the LCD display. You can access this guide through InfoExplorer.

10 Troubleshooting



Booting from maintenance mode

If you cannot start your Network Server from your hard disk, you can access
system information from maintenance mode.

To use maintenance mode to examine and restore information:

1 Insert the Installation CD or a bootable backup tape.

2 Shut down the Network Server.

Enter the command shutdown -F.

3 Turn the front key switch to the left (service) position.

4 Turn on your Network Server.

The computer starts up from the CD or backup tape.

A message appears asking you to define the system console.

5 Press F1 and then the Enter key to use the local display as your console.

You need an extended keyboard to identify your console unless you are
installing with a terminal connected to the modem port.

6 When prompted, select a language for installation instructions.

For English, type 1 and press Enter.

The following message appears on your screen.

Welcome to the Base Operating System

Installation and Maintenance

Type the number of your choice and press Enter.

Choice is indicated by >>>.

1 Start install now with default settings

2 Change/show installation settings and install

>>> 3 Start maintenance mode for system recovery

88 HELP ?

99 PREVIOUS MENU
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7 Type 3 and press Enter.

A menu appears that lists options for system maintenance.

8 Type 1 and press Enter.

The choice indicated by 1 lets you access a root volume group.

When you choose 1, the system warns you that you might overwrite existing
information and then lists the available volume groups.

9 Type the number of the volume group that you want to examine and press Enter.

A menu appears that lists the file systems on this volume group.

10 Type the number of the file system that you want to mount and examine and press Enter.

Your system lists options for mounting the file system.

11 Choose Mount File System and Start Shell.

Your system mounts the file system and provides a shell for you to enter
UNIX commands. You can use UNIX commands in this shell to examine the
file system for problems and restore corrupted information.

Maintenance

Type the number of your choice and press Enter.

Choice is indicated by >>>.

>>> 1 Access a Root Volume Group

2 Copy a System Dump to Removable Media

3 Access Advanced Maintenance Functions

4 Install from a System Backup

88 HELP ?

99 PREVIOUS MENU
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Correcting an unresponsive system

A hardware or software problem can make your Network Server
unresponsive. The suggestions in this section might help you correct the
problem and restart your Network Server. If your Network Server is still
unresponsive, refer to Setting Up the Network Server.

For an unresponsive system, first check your hardware.

m Verify that the power light is on.

If not, see the hardware guide.

m Check for a three-digit code on the LCD panel on the front of your 
Network Server.

If the display is not blank, look up the three-digit code in the section,
“System Error Messages,” later in this chapter.

m Ensure your cable connections are securely attached.

m Ensure that your terminal is on and the brightness is properly adjusted.

If your Network Server is still unresponsive, check for software problems. Often,
a stopped or stalled process may make your Network Server unresponsive.

m Use Control-D or Control-C to cancel a stalled process.

m Restart your Network Server.

Before you restart, ensure the front key is turned to the upright (unlocked)
position and the boot device is on. To restart, press the reset button.

Reset button
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Avoid running out of paging space

If paging space is inadequate, you may see the following error messages:

No more processes

killed

You may also unexpectedly be logged out. Type the following command to
check paging space:

lsps -a

You can increase paging space with the Install Assistant. For more
information, see Chapter 6, “Using System Administration Tools,” in this
manual. If you inadvertently log out and cannot restart from your hard disk,
you can restart in maintenance mode. See the section “Booting From
Maintenance Mode” earlier in this chapter.

Monitor problems

If your Network Server does not display data correctly, make sure that the
monitor is compatible. The Network Server requires a monitor with multiple
scan support, and many older monitors do not work with it. 

If the monitor is incompatible, and you experience “rolling” video, do 
the following:

1 Boot in maintenance mode.

Follow the instructions in “Booting From Maintenance Mode” earlier in this
chapter.

2 Select an appropriate video resolution.
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Problems with serial I/O port identification

The serial I/O ports are labeled s1 and s2 on the server’s back panel.
However, the AIX software considers these ports adapters and numbers 
them sa1 and sa0, respectively (s1=sa1 and s2=sa0). This is the reverse of the
relationship on IBM systems with native serial I/O support. As with all
adapters, the numbering of the associated TTY depends on the order in which
the TTYs are configured. During installation, you can define the console with
a terminal connected to the serial I/O port labeled s1 (sa1).

Problems with printer driver installation 

The Easy Install procedure in this guide does not install all the printer drivers
that some users may need. If the drivers you require are not installed, the
following steps will install them.

IMPORTANT Before proceeding with the installation, be sure that you are
logged in as root and that the AIX installation CD-ROM disc is inserted in
the Network Server.

1 Type smit install and press Return at the prompt in a terminal window.

The installation utility opens.

2 Click the “Install and Update Software” checkbox.

A software installation screen appears.

3 Click the “Install and Update Selectable Software (Custom Install)” checkbox.

The custom install screen appears.

4 Click the Install Additional Printer/Plotter Software checkbox.

A dialog box appears, asking you to specify the software source.

166 Chapter 10 / Troubleshooting



5 Type /dev/cd0 and press Return.

You can also click the List button (or press F4) and choose /dev/cd0 from
the list that appears.

The Install Additional Printer/Plotter Software screen appears.

6 Click the List checkbox next to “Software to Install.”

A pop-up menu appears. 

7 Select the printer drivers you want to install by clicking their names in the pop-up list.

If you want to select all printer drivers, click All @@ printers.

8 Click OK.

The Install Additional Printer/Plotter Software screen reopens.

9 Click OK.

A confirmation dialog box appears.

10 Click OK.

The installation process begins. 

11 When installation is complete, click Done.

12 Choose Exit SMIT from the Exit menu to return to the Common Desktop Environment.

Quantum hard drive identification

SMIT and other device commands show the 1 GB and 1.2 GB Quantum hard
drives as the type “other” instead of “1.0 (or 1.2)” GB disk drive.
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Keyboard problems

If you have problems with keyboards that use a variety of language mappings,
try the following suggestions. Contact Apple support for more information if
your problem persists. (See the Apple support brochure in your accessory kit.)

Problems using standard keyboards

It is strongly recommended that you use an Apple Extended Keyboard or an
equivalent third-party keyboard with all models of the network server. It is
sometimes possible to use a standard Apple keyboard with the Network
Server, if you use the upper row of keys on the numeric keypad to stand for
the first four function keys, as described in “Installing the AIX Base
Operating System” in Chapter 2 in this manual. This method does not work
for all languages.

For more information on keyboard mapping, see the AIX Technical Reference,
available through InfoExplorer.

Problems with number keys

The number keys on most keyboards require you to press only the number
key itself to type the number, with the Shift key also pressed to type the
second symbol, such as * or ^. Other keyboard maps, however, use the
opposite scheme, requiring you to press the Shift key when typing a number.
If this is the case, you may encounter occasional conflicts. To solve the
problem, do the following:

1 Press the number lock key on the numeric keypad on the right of the keyboard.

2 Enter all numbers from the numeric keypad.

For more information on keyboard mapping, see the AIX Technical Reference,
available through InfoExplorer.

Problems generating third symbols on keys

Apple keyboards include no more than two symbols on keys, while some IBM
keys have three. To generate the third symbol, hold down the Alternate
Graphic (AltGr) key while pressing the key you need.
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The AltGr key is always in positions 60 and 62 on the keyboard, on either
side of the Space bar. On Apple keyboards, it is the Command key.

For more information on keyboard mapping, see the AIX Technical Reference,
available through InfoExplorer.

Using Open Firmware

Open Firmware can be used to set basic Network Server parameters and to
complete some diagnostic procedures. To boot the system into Open
Firmware, restart the server while holding down these keys: 

Command-Option-O-F

You can use the following commands while in Open Firmware:

m printenv

Lists the current (left column) and default (right column) values for all the
Open Firmware variables.

m set-defaults

Sets all the Open Firmware variables to their default values. 

m setenv variable

Sets the Open Firmware variable to the value listed. Note that some
variable changes take effect immediately, others only after rebooting. 

m setenv input-device ttya:9600

Sets the input device to serial port “a” at 9600 baud.

m setenv output-device ttya:9600

Sets the output device to serial port “a” at 9600 baud.

m setenv input-device kbd

Sets the input device to the attached ADB keyboard.

m setenv output-device screen

Sets the output device to an attached monitor.

Avoid running out of paging space 169



m probe-scsi0

Lists all the devices connected to the external SCSI bus.

m probe-scsi1

Lists all the devices connected to the first (top) internal SCSI bus.

m probe-scsi2

Lists all the devices connected to the second (bottom) internal SCSI bus.

m password

Sets the Open Firmware password. By default the Open Firmware
password is the same as the AIX root password. If you change the Open
Firmware password, changing the AIX password no longer changes the
Open Firmware password.

m boot

When the front key on the server is turned to the upright (normal) or right
(locked) position, the server boots from the device listed as boot-device.
When the front key is turned to the left (service) position, the server boots
from the device listed as diag-device.

m shut-down

Turns off server power.

m reset-all

Reboots the server and forces changed variables into effect.

m .keyswitch

Reports the position of the front keyswitch (service, normal, or locked).
Note the leading period. 

Restoring the Open Firmware password

If you forget the Open Firmware password, do this:

1 Turn the front key to the left (service) position.

2 Reboot the system, then immediately hold down the following keys:

Command-Option-P-R

This resets the parameter RAM (PRAM).
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3 Reboot the system in maintenance mode.

See “Booting From Maintenance Mode” earlier in this chapter.

4 Reset the system date.

5 Reset the AIX root password to null.

When you reassign an AIX password, the Open Firmware password will be
the same.

Using the Network Server Diagnostic Utility

You can use the Diagnostic Utility to verify the hardware configuration and
run a variety of system tests. For more information, see the Read Me file on
the Network Server Diagnostic Utility floppy disk, or check the information
available through the Network Server button at this World Wide Web site:
http://www.solutions.apple.com.

System error messages

Most error messages you see can be looked up in InfoExplorer. This section
lists messages and recommended actions for situations when you cannot
access InfoExplorer, such as during installation.

Three-digit display error codes during system startup

For most problems with the booting process, a three-digit error code appears
on the LCD panel on the front of your Network Server. This section lists the
possible error codes and recommended action. For the procedures in this
section, you must have root privileges.

This section describes the display values for system startup.

The error codes in the following table require you to run a hardware
diagnostic program to isolate and correct the problem. This table tells you
what device is causing the problem and at what point in the boot cycle.
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Display value System action

510 The system has started the Configuration manager. 
511 The Configuration manager has completed. 
517 The system is attempting to mount the / (root) and /usr file systems. 

These file systems are of type bootfs. If the mount does not successfully 
complete during a network boot, the system changes the three-digit display 
value to 518. 

538 The configuration manager is passing control to a configuration method.
539 The configuration method has completed.
551 The system is attempting to vary on the root volume group.
553 The system has completed phase one of the boot process.
585 The system is configuring the network. 
591 The system is configuring the Logical Volume Manager (LVM). 
593 The system is configuring the low-function graphics terminal.
594 The system is configuring an asynchronous I/O. 
704 The system is configuring the 2.2 GB 16-bit SCSI disk drive. 
723 The system is configuring an unknown CD-ROM or SCSI device driver. 
727 The system is configuring an asynchronous device. 
731 The system is configuring an unknown PTY. 
811 The system is configuring the processor complex or the standard 

input/output.
812 The system is configuring the memory. 
814 The system is configuring the NVRAM. 
821 The system is configuring the standard keyboard adapter.
823 The system is configuring the standard mouse adapter. 
826 The system is configuring serial port 1.
828 The system is configuring the standard floppy disk adapter. 
831 The system is configuring the serial port 2. 
868 The system is configuring the integrated SCSI adapter. 
874 The system is configuring the graphics subsystem adapter. 
890 The system is configuring a SCSI-2 adapter.
891 The system is configuring a RAID card.
921 The system is configuring a keyboard. 
925 The system is configuring a three-button mouse. 
935 The system is configuring a 3.5-inch disk drive. 
9002 The system is configuring the 825 SCSI card.

172 Chapter 10 / Troubleshooting



Error Code 522

The display value 522 indicates that the /etc/inittab file has been
incorrectly modified or is damaged and the configuration manager was started
from the /etc/inittab file with conflicting options. This causes the
system to stop.

You can solve this problem by entering maintenance mode and either
correcting the damaged file or replacing it with a copy from the installation
media or another system.

Error Code 551

If the boot process halts with a display value of 551, there may be a problem
with any of the following.

Problem Solution

/dev is missing or corrupted mkdir /dev

bad boot logical volume bosboot -a

/etc problems restore selective files (if possible) or reinstall

If these solutions do not correct the problem, try the following command
from maintenance mode:

fsck hdiskn

where n is the number of the hard disk that contains the root volume group.
The fsck command checks file system consistency and repairs the file
system.

Error Code 552

The 552 error code indicates that the Network Server is in an infinite loop. To
fix the problem, clean up the file system (using the fsck command) and
examine the log volume.

To examine the log volume, run the following command at the maintenance
mode prompt for the root volume:

/etc/aix/logform /dev/hd8

This command reformats your log logical volume. After you run this
command, restart your Network Server.
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Error Code 553

If the Network Server stops at display value 553 during the boot process,
there may be a problem running or reading the /etc/inittab file. The
/etc/inittab file controls the initialization process. This problem occurs
when /tmp or root (/) file systems are full.

To solve this problem:

1 Boot from maintenance mode and access the root volume group.

2 Check for available space on the file system.

Use the df command to check for space. For example, enter

df -1 /dev/hdisk0

3 Erase files as necessary to get disk space.

Often the /smit.log and /smit.script files cause the problem.
Remove them with the following command:

rm /smit.log /smit.script

4 Examine the /etc/inittab file for corruption.

The file may be empty or missing or it may have an incorrect entry. You may
have to recreate this file or fix an entry.

5 If the /etc/inittab file is not corrupt, look for modification or permissions
problems with the following files: /etc/environment, /bin/sh, /bin/bsh,
/etc/fsck, /etc/profile, /.profile.

6 Return the front key to the upright (unlocked) position and restart your Network Server.

Error Code c31 or c32

If the Network Server stops at value c31 or c32, it is trying to locate the
system console. The Network Server may not locate the console if the console
is defined but not enabled or if the console is a TTY that cannot be reached.
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First, look for loose cables. If the cable connections are correct, boot into
maintenance mode and enter a shell for the root volume group. Enter the
following command to enable the console:

chcons -a login=enable /dev/hft/0

Restart your Network Server.

System messages during installation

This section lists the messages that can appear during the installation of AIX.
In this section, the messages that appear on your screen are in the Courier
font; recommended actions follow the messages. 

0516-404 allocp: Not enough resources available to fulfill

allocation. Either not enough free partitions or not

enough physical volumes to keep strictness. Try again with

different allocation characteristics.

0516-788 extendlv: Unable to extend logical volume.

0503-008 installp: There is not enough free disk space in

file system /usr. An attempt to extend this file system

was unsuccessful. Make more space available, then retry

this operation.

These messages indicate that there is not enough space to complete the
installation. To solve the problem, do one or more of the following:

m Select fewer file sets than the number originally selected for installation.

m Extend the root volume group to another disk. Enter

extendvg rootvg hdiskn

where n is the number of the specified disk.

m Remove user-defined file systems to free space in the rootvg file system.

BOS install: After saving all the data from the previous

system in /tmp, it was discovered that there will not be

enough free space in /tmp to make the boot image. Please

reboot in normal mode and increase the size  of /tmp or

reduce the number of files to save as listed in the

/etc/preserve.list file.
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During a preservation install, files listed in /etc/preserve.list were
copied into /tmp. After doing this, there was not enough room in /tmp

to create the boot image. Reboot your Network Server in normal mode and
increase the size of /tmp or reduce the number of files to be saved.

BOS install: Could not create boot image.

The bosboot command failed. Check the
/var/adm/ras/devinst.log file for errors.

The following disks failed the preliminary diagnostic

tests: <disk name>.

The installation disk failed the diagnostic pretest. Run full diagnostics on
the specified disk.

image.data file contains no vg_data stanza for rootvg.

The installation cannot continue.

image.data has invalid logical volume data. Cannot

continue.

image data has invalid file system data. Cannot

continue.

Use the default image.data file on the Installation CD.

0516-366 putlvodm: Volume group rootvg is locked. Try

again.

0516-788: extendlv: Unable to extend logical volume.

0503-008 installp: There is not enough free disk space

in the file system /usr. An attempt to extend this file

system was unsuccessful. Make more space available, then

retry this operation.

One of these messages might occur if you have interrupted the installation 
of your optional software. When you interrupt an installation, the Network
Server sometimes locks the root volume group. 
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To unlock the root volume group:

1 Log in as root.

2 Enter chvg -u rootvg.

3 Enter smit_install and attempt to install your optional software again.

installp: An error occurred during bosboot processing.

Please correct the problem and rerun.

0301-152 bosboot: not enough file space to create:

/tmp/unix.

The bosboot command is unable to finish because of insufficient space in
/tmp. Extend the /tmp file system (use smit chfs), or free some space
and restart your Network Server.

installp: An error occurred during bosboot processing.

Please correct the problem and rerun.

301-155 bosboot: Invalid or no boot device specified.

An invalid device is specified. The bosboot command could not complete
because it could not locate the required boot device. To solve the problem,
determine if the link to the boot device is missing or incorrect. Correct the
error and complete installation. 

1 To identify the book disk, enter 

lslv -m hd5

The Network Server displays the name of the boot disk.

2 Create a link between the boot device indicated and the /dev/ipldevice file
by entering

ln /dev/boot_device_name /dev/ipldevice

An example of the boot_device_name is hdisk0.
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3 Rerun or continue the installation.

No disks are available.

No hard disks are configured on the Network Server. You can only use the
maintenance option of the installation program. You can view the devices file
from the maintenance shell by entering the following command:

cat /etc/objrepos/devs

Turn off your Network Server and examine devices to ensure that all SCSI
devices are unique and that SCSI devices are properly terminated. Also, 
check the physical connections between devices. Then restart and try the
installation again.

If these steps do not work, run diagnostics on your hard disk.

Slow startup problems

If there are errors in the TCP/IP configuration of your Network Server or the
configuration information is no longer correct for your network, you may
experience one or more of these problems:

m the server may take a long time to start up

m CDE may take a long time to log in or log off

m applications may not open from CDE or perform properly

m dterm or SMIT sessions may not start

For example, if you disconnect your Network Server from the network
without stopping network services, or if you move it to another location on
the network without reconfiguring the server for its new location, the server
may take a long time to start up.

This section describes how to restart your server so that you can correct TCP/IP
problems and how to correct problems that affect the performance of CDE.
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Restarting in maintenance mode

If your Network Server is taking a long time to start up, you can restart the
server in maintenance mode. You can then correct any network configuration
information before restarting the server normally.

For information about restarting the server in maintenance mode, see
“Booting From Maintenance Mode” at the beginning of this chapter.

After you have restarted the server in maintenance mode, you can perform
one of these steps:

m If you have disconnected the server from the network, stop all services that
require network services.

m If you have moved the server to another location on the network,
reconfigure the TCP/IP information for the server for its new location. For
information about configuring TCP/IP, see the InfoExplorer.

After you have performed one of these tasks, restart the server as you
normally do.

Correcting CDE problems after the host name has changed

If the host name changes after the CDE parent process (dtlogin) has
started, the X variable, DISPLAY, will not be correct. This will result in CDE
starting slowly or performing poorly.

To correct this problem, perform these steps:

1 Log out of CDE.

2 Execute the following command to get the process ID for the dtlogin process:

ps -ef |grep dtlogin

After you execute the command, a list of the processes running on the server
appears, as in this example:

root 2990 1 0 Apr 02 - 0.00 /usr/dt/bin/dtlogin -daemon

root 3516 2990 0 Apr 02 - 0.00 dtlogin <:0> -daemon

The process ID is the first number that appears after the name of the process
owner. In the example,“root” is the process owner.
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3 Execute the following command to kill the dtlogin process:

kill <dtlogin process ID>

Use the process ID for the dtlogin session with a parent ID of 1. The
parent ID appears after the session ID.

IMPORTANT Do not use kill -9.

4 Execute the following command to get the process ID for the dtsession process:

ps - ef |grep dtsession

5 Execute the following command to kill the dtsession process:

kill <dtsession process ID>

6 Restart CDE and dtlogin using the following command:

/etc/rc.dt

CDE should now be using the current host name and the DISPLAY variable
should be correct.

CDE starts slowly when using a DNS server to resolve names

You can configure AIX to query a DNS server to resolve host names and
addresses. With this configuration, AIX queries the server before it executes
the /etc/hosts file, which can contribute to CDE taking a long time to start. To
speed up starting CDE, you can configure AIX to use the hosts file before it
requests names from the DNS server.

To configure AIX to get the host name from the /etc/hosts file:

1 Create a file called /etc/netsvc.conf.

2 Add the following line to the file:

hosts =local, bind

WARNING This procedure can result in your server not having the current host
names and IP addresses defined by the DNS server for network services. Be
sure to revert to using the DNS server to resolve names as soon as possible
after you resolve the problem with CDE and TCP/IP. If you don’t, applications
or services that use network services may not work if host names and
addresses change.
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How to start reconfiguring TCP/IP

This section describes how to start reconfiguring TCP/IP if you need to do so
to correct a problem. See the InfoExplorer for complete details on how to
configure TCP/IP for your Network Server.

1 Perform one of these tasks:

m If CDE is hung, press the Control, Alt, and Delete keys to stop the X server.

m If CDE is running, log out of CDE.

2 In the AIX log-in window, click the Options button and press the Return or Enter key to
begin a command line log-in.

3 Log in as root.

4 Execute the following command to open the TCP/IP configuration window:

smit tcpip

5 Press Return or Enter to select the Minimum Configuration and Startup options.

6 Select the interface you need to configure.

For example, to configure the built-in Ethernet interface, select en0.

7 Enter the TCP/IP information requested in the window.

IMPORTANT Do not select Yes for the Start Now option.

8 When you are finished entering information, press Return or Enter.

9 Press the F10 key to exit the TCP/IP configuration window.

10 Shutdown and restart the server by executing the following command:

shutdown -Fr
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If you continue to have problems

If you continue to have problems starting your server or using CDE, the
TCP/IP configuration for your server may have other problems. For example,
the /etc/hosts file may be corrupted. For help determining the cause of these
problems, see the InfoExplorer or contact your Apple support provider for
assistance.
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This preface describes

m Apple software provided with AIX®

m what’s in this manual and who should use it

m the available print and onscreen documentation

m special terms used in this manual

What the Network Server software offers

The software described in this manual contains IBM’s AIX (version 4.1.5)
operating system for use on the Apple Network Server. In addition, Apple
Computer, Inc. has supplied AppleTalk networking services to work with
AIX, and two applications that use a Macintosh interface for handling UNIX®

tasks. These are the Disk Management Utility and CommandShell (which is
used for terminal emulation).

Who should use this manual

This manual is for system administrators and users of AIX on the Network
Server. It is meant for those who are familiar with basic UNIX system
administration techniques, but who are not familiar with AIXwindows, the
Common Desktop Environment™, InfoExplorer™, or the software that Apple
Computer, Inc. has included with AIX. 
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How to use this manual

This manual offers the basic information necessary to get up and running
with AIX on the Network Server. Detailed information on the use of the AIX
operating system and on system administration is available on screen. For a
discussion of the onscreen documentation, see “Documentation and Onscreen
Information,” next.

Chapter 1 introduces you to the basic hardware and software configurations,
user interfaces, and standard AIX system management tools.

Chapter 2 describes installation of the AIX Base Operating System (BOS)
and additional software from Apple Computer (the Disk Management Utility
and CommandShell).

Chapters 3 through 6 discuss system startup and shutdown, the use of the
AIXwindows graphical interface and the Common Desktop Environment, the
use of the InfoExplorer onscreen documentation system, and basic AIX
system administration tools.

Chapters 7 through 9 describe how to set up AppleTalk networking services,
how to manage file storage with the Disk Management Utility, and how to use
CommandShell for remote access.

Chapter 10 offers assistance with error messages and troubleshooting.

Documentation and onscreen information

This manual is the only printed documentation that comes with AIX and 
the Apple software for the Network Server. However, you should also 
have the manual Setting Up the Network Server, which is included with the
Network Server.
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In addition, you can read or print IBM’s AIX documentation using the
InfoExplorer hypertext retrieval system, which is described in detail in
Chapter 5. InfoExplorer makes available to you a wide range of user and
system administration documentation, including the AIX 4.1 Getting Started
guide, upon which this manual is based.

For quick-start instructions on consulting IBM documents with InfoExplorer,
see “Using InfoExplorer to Learn InfoExplorer (Graphical Interface)” or
“Using InfoExplorer to Learn InfoExplorer (ASCII Interface),” in Chapter 5
of this manual.

Users interested in learning more about AIX commands should consult the
information in the AIX Version 4.1 System User's Guide: Operating System and
Devices. Users in a networking environment who are interested in learning
more about AIX communications commands should consult the 
AIX Version 4.1 System User's Guide: Communications and Networks.
For information on ordering this documentation, published by IBM, call 
800-879-2755. From outside the United States, call 919-850-7500.

Terminology used in this manual

This section explains the terminology used in this manual to refer to modifier
keys and to various mouse and keyboard operations. 

Modifier keys

If you are using a keyboard that doesn’t have an Alt key, use the Option key
wherever this manual refers to the Alt key. 

Mouse buttons

Some users use a three-button mouse and some a one-button mouse. The
instructions in this manual are written for a three-button mouse, as are the
IBM documents that you can display with InfoExplorer (see “Documentation
and Onscreen Information,” earlier in this chapter). 
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If you are using a three-button mouse, the phrase the mouse button refers to
the first button (often called the leftmost button or Mouse Button 1) on your
three-button mouse. When this manual asks you to perform a mouse action,
such as clicking to select an object, use the first button unless the instructions
say otherwise.

If you are using a one-button mouse, wherever this guide instructs you to 
press the right mouse button, press the Caps Lock key and the Right Arrow
key on the keyboard. For the equivalent of the middle button on a three-
button mouse, press the Caps Lock key and the Left Arrow key.

Basic mouse and keyboard operations

In this manual, some terms represent a series of actions that you perform with
the mouse, keyboard, or both. For example, the word enter indicates that you
type a character (or a series of characters), then press the Return key. 

Here is a list of standard terms for mouse and keyboard operations and the
meaning of each term. 

=

=

=

xvi Preface



Term Action

Click Point to the object and then press and immediately release the 
mouse button.

Double-click Point to the object and then press and release the mouse button twice
in quick succession without moving the pointer.

Drag Point to an object on the screen, such as an icon that you want to
move. Press and hold down the mouse button while moving the mouse
until you have accomplished the desired task, such as moving the icon
to a new location, and then release the mouse button.

Choose Activate a command in a menu by pressing the menu title and
dragging (usually downward) through the menu until the command you
want is highlighted. Then release the mouse button.

Point Move the mouse to position the pointer over an object on the screen.

Select Designate where the next action will take place. To select an object
such as an icon, point to the object and click the mouse button once.
When selected, the object appears highlighted. To select text, drag
across the text until the entire range of text that you want to select is
highlighted.

Type Type a series of characters without pressing the Return key.

Press Press a single key or key combination without pressing the Return key
afterward, or point to an object and then press and hold down the
mouse button without moving the mouse.

Enter Type a series of characters and then press the Return key.

This manual refers to the Return key, although your keyboard might label it
the Enter key.
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